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       13 

Introduction 
This manual provides the basic introduction to operation of the Nexsa G2 XPS instrument 

using Avantage V6. For additional information, see the Avantage online help and manuals. 

For safety instructions read the 1213766 Nexsa G2 Safety Manual.  
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Avantage Introduction 
 Each part of the software is described in the relevant section in this 

manual. Further information can be found in the Avantage help file, in 

the Help menu. 

 

 

Figure 1: Main Screen Layouts 
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16      Avantage Introduction   |   Status Indicators 

  

Figure 2: Main Command Menu Toolbar Icons 

Status Indicators 

 The status of the sources and the sample bias is shown by the 

indicators at the bottom left of the Avantage screen. 

Indicators Description 

 
No colour and a grey text label indicate that the gun is Off or the sample 
bias is not being applied. 

 
Flashing blue indicates that a source is ramping or running a 
degas/conditioning routine. 

 

Green indicates that a source is on and running 

Ion gun – unblanked and etching 

Sample bias – bias is being applied) 

 

A red indicator indicates no communications to source hardware. 

See “Troubleshooting” section 

 Ion gun only: Yellow indicates source is on and blanked (not etching) 

 Flood gun only: Yellow indicates filament conditioning 
 

Table 1: Status Indicators 
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System Status Panel 

 

Figure 3: System Status Panel 

 The instrument status panel indicates the current condition of the 

instrument. 

Technique indicators An orange indicator shows that a technique is available on 
the system. A green indicator shows which technique is 
currently being used to acquire data. If a technique is not 
installed, the indicator is not lit. 

Status indicators These indicate the instrument status. A green light shows 
that the status is OK, an orange LED indicates that the 
system is not OK for data acquisition. 

Vacuum indicates if the vacuum level is OK to start the 
sources. 

Water indicates that the water flow to the instrument is 
good enough to allow the X-ray source to be 
used. 

Comms indicates that Avantage is open and 
communicating with the instrument 

Experiment running A blue light scans when the system is acquiring data. 
 

Table 2: System Status Panel Description 

Technique 

indicators 

Experiment 

Running 

indicator 

Status 

indicators 
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18      Sample Holders and Sample Mounting   |   Status Indicators 

Sample Holders and Sample 

Mounting 

 

Figure 4: Sample Holders 

 • Always use gloves and tweezers to avoid contamination of the 

sample surface. Try to avoid touching areas that you wish to 

analyse. 

• Samples are usually mounted onto a standard sample holder 

using the spring clips provided.  

 

Figure 5: Spring Clip 

 • Alternatively, conducting carbon adhesive tape may be used.  

• Samples must not go outside the area of the top plate and must 

not overhang the edges of the holder. This is to prevent samples 

hitting surfaces inside the system during transfer, which could 

cause internal damage to the transfer mechanism. 
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Figure 6: Good Sample Mounting (Left) and Bad Sample Mounting (Right) 

 

Figure 7: Clips Holding the Sample Top Plate 

 • The top plate can be replaced by removing the four clips at the 

edge of the holder. The top plate can then be lifted out.  

 

Figure 8: Source orientation around the sample holder 

NOTE: The diagram displayed shows the options fitted 
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 • Care should be taken where different samples of different 

thickness are to be analysed to avoid shadowing of the X-ray, 

ion or flood gun by the thicker samples. The diagram above 

shows the source orientation as seen by the system cameras. 

 • Depending on the sample thickness, the height of the top plate 

may need adjusting; this is done using the two screws on either 

side of the sample holder. The table below shows the screw 

positions and the sample thickness that can be analysed. Note 

that only samples of a thickness within the range can be 

analysed at a particular setting. For example, if the top plate is 

set to the middle position, for thicknesses of 5-10 mm, then 

samples of 0-5 mm would have to be attached to supports to 

bring them into the 5-10 mm thickness range. 

Screw Position Image Sample Thickness 
Range (mm) 

Lowest position (default) 

 

0-5 

Middle position 

 

5-10 

Top position 

 

10-15 

Top plate removed 

 

15-20 

 

Table 3: Sample Thickness and Screw Position 
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Rotation Holder 

 To set up the holder for rotation depth profiling, first remove the top 

plate from the holder as described above. Choose the correct rotation 

stub depending on the sample thickness (largest stub – 0-5 mm 

sample thickness, medium stub – 5-10 mm sample thickness, 

smallest stub – 10-15 mm sample thickness).  

 The stub screws into the hole in the base of the sample holder; it is 

best to hold the gear underneath the holder still whilst doing this to 

ensure that the stub is fixed tightly in position. 

 

Figure 9: Rotation Stub Attachment Point 

 The optional top plate with a hole can be used to mount additional 

samples when a rotation stub is used. Remember that the height of 

the top plate may need adjusting down to prevent the samples being 

shadowed if the medium or small stubs are used. 

 

Figure 10: Rotation Holder 

Rotation stub 

attachment 

point 
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22      Sample Holders and Sample Mounting   |   Powder Holder 

Powder Holder 

 Powders can be mounted either by pressing onto tape and using the 

standard top plate, or by pressing into the recesses on the powder 

top plate. To use the powder top plate, first remove the top plate from 

the holder as described above, and then attach the powder top plate 

using the four spring clips.  

 Powder should be pressed into a recess, ensuring that the powder 

surface is level with the surface of the top plate. Care should be taken 

to minimize the amount of loose powder on the holder, as this can 

become mobile in the system during pump down. 

 

Figure 11: Powder Holder 
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Fibre Holder 

 Fibres can be mounted using the supplied top plate with channels. To 

use the fibre top plate, first remove the top plate from the holder as 

described above, and then attach the fibre top plate using the four 

spring clips. Fibres should be stretched horizontally across the 

channels and either clipped or taped into place. This ensures that the 

XPS signal is just from the fibre, and there is no contribution from the 

sample holder. It also allows large X-ray spot sizes to be used, to 

maximise the signal.  

 Care should be taken to ensure that no fibre overhangs the sample 

holder, which could get caught during the sample loading process. 

 

Figure 12: Fibre Holder 

Additional Sample Holders 

 Details of the optional sample holders can be found in the section 

“Optional Sample Holders” (Page 127). 
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24      Sample Loading   |   Additional Sample Holders 

Sample Loading 
 Before loading samples into the system always check that the 

maximum height of the samples is suitable by checking with the 

loading gauge arm.  It should move across the sample holder without 

touching the top of the samples. 

 

Figure 13: Checking Maximum Height 

CAUTION Do not load samples that are touched by the loading test gauge. 

Do not attempt to load samples that are outside the edges of the 

top plate 

 The sample is loaded onto the plate in the entry-lock as shown, 

ensuring that the two holes on the bottom of the holder (white arrows) 

engage correctly with the pins on the carrier plate (black arrows). 

 

Figure 14: Loading a sample 
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The Sample Page 

 
The Sample page is used to load and unload samples. It also 

provides buttons to access the Engineer Details Pages for Vacuum 

Control, X-ray, Ion and Flood Guns, and displays the pressure in the 

analysis chamber.   

 A diagram indicates the orientation of the fitted sources (X-ray, Ion 

source & Flood Gun, plus optional UV lamp and Raman system) 

relative to the sample holder and provides access to the source 

details windows (for engineer use only). If the sample tilt module has 

been purchased, the check-box control to inform the system that it is 

loaded should also be displayed (please see the Optional Sample 

Holders section, page 127, for more information about the tilt 

module). 

 

Figure 15: Description of the Sample Tab 

(* Tilt Module Only) 
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Sample Handling Controls 

 The buttons at the top of the sample page control the movement of 

the sample in and out of the analysis chamber, and allow the entry-

lock to be vented. The buttons are context sensitive, and the control 

displayed depends on the location of the sample holder. 

 When the entry lock is vented the following buttons are enabled: 

 

Pump and transfer to the analysis position. 

 

Pump and park in the entry lock. The park position may be 
useful for allowing samples to outgas for a longer period. 

 

Close the entry-lock door. This does not start the entry-lock 
pump. It is recommended to use this button when changing 
samples to keep the chamber and door o-ring seal clean. 
(Visible if door is open) 

 

Open the entry-lock door. (Visible if door is closed) 

 

Abort the current operation. Depending on the process 
running this may take a few minutes to complete. 

 

Table 4: Buttons Enabled when Venting the Entry Lock 

 The entry-lock chamber pressure is monitored, and the sample will 

not be transferred into the analysis chamber until the pressure is 

below a threshold level. 
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 When the entry lock is pumped down, and the sample holder is in the 

park position the following buttons are enabled: 

 

Transfer to the analysis position. If the pressure in the entry-
lock is not below the threshold level, then the system will 
wait until the vacuum is good enough. 

 

Vent the entry-lock and open the door 

 

Collect a new platter view image. 

 

Abort the current operation. Depending on the process 
running this may take a few minutes to complete. 

 

Table 5: Buttons Enabled when the Entry Lock is Pumped Down 

 When the sample holder is in the analysis position the buttons are 

enabled: 

 

Transfer to the entry lock, vent to atmosphere and open the 
door. 

 

Transfer to the entry lock and park the sample block. 

 

Abort the current operation. Depending on the process 
running this may take a few minutes to complete. 

 

Table 6: Buttons Enabled when Sample Holder is in the Analysis Position 
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 When any transfer process is completed, the buttons are re-

enabled. The entire vacuum and transfer sequences are automated. 

After transfer to the analysis position, the sample holder is raised to 

approximately the normal analysis position (Z~35 mm). 

PLC Command Status 

 When a vacuum sequence is in progress, the status and details of 

current command are displayed below the sample movement buttons.  

The Current Command window indicates the routine that is running; 

the Command Status window displays the step that is currently in 

progress.  

 

Figure 16: PLC Command Status 

Automatic Running of the Experiment 

 A predefined experiment file can be run automatically after the 

sample has been transferred and a defined time has elapsed. This 

function is usually used with samples that are known to out-gas 

significantly during pump-down. To use this feature, first pump-down 

the samples using the Pump and park in the entry lock button. 

Click the checkbox to enable the wait, transfer and run experiment 

mode, and type the required wait time (in minutes) into the adjacent 

text box.  

 

Figure 17: Automatic Running of the Experiment 

 Next define the experiment or load an existing experiment (see later 

sections in the manual for how to define experiments). Remember 

that points, lines or areas will have to be defined from the Platter 

View, and that auto-height should be used in the absolute mode. 

When the experiment is ready, press the Transfer to the analysis 

position button; a small window will open indicating the time until the 

transfer will be attempted.  

 If the pressure is not good enough at this time, the system will wait 

until the pressure is acceptable before loading the samples and 

running the experiment. This procedure is most suitable for large area 

analyses. 
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Details Pages 

 All users may view the Details pages but only users that have 

Avantage Engineer access level will be able to change settings. See 

Avantage Help > Index > Add User for further information about this 

restricted access. 

 Many of the operations on the Details pages are for engineers only, 

and in normal operation they are not required. Please see the 

Maintenance & Troubleshooting section, and the relevant Option 

sections for information on use of the details pages. 

 

Figure 18: Buttons to open details windows 

(layout seen depends on the options fitted) 
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The Optical View: Sample 

Navigation and Lighting 
 The Optical View is used to navigate around the sample and select 

features for analysis by using the following: 

Platter view Photograph of the sample holder taken whilst it is in the load-lock 

during pump-down. Used to move from sample to sample, and to 

define experiment positions. 

SnapMap Rapid XPS mapping for feature identification & alignment. 

Live optical view Switchable between the through-the-lens (TTL) camera view and the 

height-set camera view. Used to move the stage, and to define 

experiment positions. The stage can only be moved up and down 

(along the Z-axis) when the height-set view is displayed. 

Lighting controls Used to control the three light sources on the system 

X-ray spot size Control to adjust the X-ray spot size of a selected point, line, or area. 

Experiment insert 

controls 

Used to insert points, lines, areas, depth profile experiments and 

auto-analysis experiments. 

Defined positions Allows quick movement to the standard positions for calibration, or 

user defined positions. 

 

Platter View 
SnapMap 

 
 

Live View 

Control toolbar 
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Figure 19: Optical View Window 

 

The Optical View window is started from the toolbar button or from 

the main Avantage menu Window > Open > Optical View. 

Light Controls 

 There are two in-system light controls, one for the co-axial light in the 

Reflex camera view, and one mounted at an off-axis angle on the 

chamber (side light). Lights can be used individually or in 

combination. The third control adjusts the bench light above the entry 

lock door. (the system internal lights – “cladding lights” – are 

controlled through the vacuum details page, see Figure 67). 

 Different types of sample may benefit from adjusting the lighting as 

shown below, generally flat samples are better with the co-axial light, 

and rough samples work better with the side light. 

 

Figure 20: Different Samples 

 Each light has an On/Off button (the lamp icon on the left) and a level 

control. 

 
Analysis chamber  

co-axial light 

 
Analysis chamber  

side light 

 
Bench lights 
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Sample Navigation 

 • Double-click with the left mouse button on a feature in either the 

platter view, SnapMap or the live optical view (TTL view only) to 

move to that feature. 

• The buttons around the image can also be used to move the 

sample in X, Y and Z directions and also Rotation or Tilt on 

applicable sample holders. 

• The digital zoom facility allows the field of view to be selected to 

help when viewing small features  

• The camera view can be switched to the height setting camera 

using the red and blue icon in the lower left corner of the live 

optical view.  
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SnapMap (Optical View) 

 SnapMap in the optical view is used to collect a total counts XPS 

image at a specified binding energy for feature visualisation and 

alignment. SnapMaps can also be collected as part of an experiment, 

which allows the data to be processed and used analytically, and is 

described later in this manual. SnapMap is controlled from the 

SnapMap section of the optical view toolbar. 

 

Run SnapMap. Collects an image using the current settings, centred 

on the current position in the Live View window 

 

Abort SnapMap. Stops acquisition of a SnapMap. 

 

Open SnapMap settings. Used to configure the acquisition 

parameters (peak position, scan size, scan mode). 

 

Figure 21: SnapMap settings window 
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 Before running a SnapMap, the acquisition parameters need to be 

set. Open the SnapMap settings from the control toolbar. The centre 

energy position for the SnapShot spectrum acquired during the 

SnapMap needs to be selected first, either by choosing an element 

from the periodic table, or typing a value into the Centre Energy 

dialog box. The map size (0.1, 0.25, 0.5, 1, 2, or 3 mm2) and the pixel 

resolution (50 x 50 or 100 x 100) should then be set. The image 

quality determines the speed of acquisition. “Coarse” mode uses an 

“S” raster with no backlash compensation, which is fast, but may give 

a noisier image than “Fine” mode, which uses a fly-back raster and 

has backlash compensation enabled. Finally, the check box should 

be set for the flood gun. 

 SnapMap acquisition is started by pressing the “Run SnapMap” 

button. The centre of the SnapMap is defined by the centre position in 

the Live View window. Once the SnapMap is acquired, it can be used 

to define experiment positions in exactly the same way as the other 

views in the Optical View window. 

Acquisition can be aborted using the Abort SnapMap button. 

Saving the Optical Image 

 • Click right in the Optical View window you wish to save and 

select Save Image. 

• The image may be saved in several standard formats or as an 

Avantage (.vgd) data file for further viewing and processing within 

Avantage.  When saved as .vgd format, the field of view 

information is also saved. 

• It is also possible to automatically save an optical image at any 

defined Point during an Experiment.  Check the Save Video 

Image in the Point property page (see Figure 23). 
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Defining Named Points 

 The Optical View allows multiple sample stage coordinates to be 

given a name and stored for future use, independent of an 

Experiment. This can be useful when analysing a number of areas on 

a sample, or when a number of different samples are to be analysed. 

NOTE: Standard Test Sample positions start with an underscore (e.g. 

_Silver) and users should not create new names beginning with 

an underscore.  Names starting with underscore character can 

only be edited by users with Avantage Engineer access. 

 

Figure 22: Named Points Controls 

Moving to a Named Point 

 • Select the named point from the list box 

• Press the  control. 

• Whilst the sample is moving, the stage can be stopped by 

pressing the  control 

• A named point may also be selected in the Point Property page. 

Deleting Named Points 

 • Select the named point that is to be deleted from the list box. 

• Press the  control. 

Optical View Properties Page 

 The Optical View has one Property page which is displayed by 

selecting Properties form the right click menu in the main display 

window. 

 This allows adjustment of the contrast, colour and brightness of the 

camera generating the displayed image but it is usually preferable to 

adjust the quality of the image by changing the setting of the light 

source.  
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36      The Experiment Tree & the Properties Panel   |   Optical View Properties Page 

The Experiment Tree & the 

Properties Panel 
 The Experiment page contains the experiment run buttons, the 

experiment tree (the area where the experiment objects are 

displayed), and the properties panel, where parameters for a 

highlighted experiment object can be viewed and edited. It is 

displayed by clicking on the  tab.  

 Experiment objects may be inserted from the optical view, as 

described in the section Choosing an Analysis Position (page 39), 

but the object insert buttons are also available for this purpose. The 

spectrum insert button is always used to add spectra to an 

experiment. 

 

Figure 23: Experiment Panel 
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Figure 24: Object Properties Panel 

 
Run complete experiment 

 
Run experiment from selected step 

 
Pause experiment 

 
Stop experiment (at the end of current scan) 

 
Abort experiment (stop immediately) 

 

Spectrum insert icon 

• Multi Spectrum – open periodic table to insert regions, surveys, 

snapshots using default parameters 

• Scanned – insert scanned spectrum 

• Snapshot – insert snapshot spectrum 

• Raman Spectrum – insert Raman spectrum (available if iXR 

Raman option has been purchased) 

 

Point insert icon 

• Manual Point – undefined position 

• Multi-point – insert multi-point object 

• Point – insert point object 

 

Line insert icon 

• Stage Tilt – insert tilt object for ARXPS (needs tilt module 

option) 

• Line Scan – insert line scan object 
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38      The Experiment Tree & the Properties Panel   |   Optical View Properties Page 

 

Area insert icon 

• Area Control – insert area object 

• Circular Area Control – insert  a circular area  

 

Source insert icon 

• X-ray Gun 

• Gun Shutdown – enables all sources to be turned off at the end 

of the experiment 

• REELS Source – available if REELS option purchased 

• ISS Source – available if ISS option purchased 

• UV Source – available if UPS option purchased  

• Manual Source Gun – mainly for legacy instruments 

 

Ion Gun insert icon 

• Depth Profile – for etching and acquisition 

• Ion Beam Etch – for etching only 

 

Processing insert icon 

• Load file – load a data file 

• Experiment Processing Object – allows addition of processing 

steps to the experiment (peak fitting, peak table profile, etc). 

See Avantage help for more details 

 

Miscellaneous insert icon 

• Group – group together objects for easy copying, management 

etc. 

• Instrument Iteration – engineer use only 

• Iteration – multi-level data collection, e.g. for time-resolved 

experiments. 

• User Message – pause the experiment to display a message 

• Wafer Registration – Theta300 system only 

• Wait Object – pause the experiment. This can be programmed 

to allow the TSP to fire (if required before a depth profile for 

example) 

 

Image insert icon 

• SnapMap – insert default SnapMap object 

 
 

Table 7: Experiment Controls 

1213765/C - Production



 

Nexsa G2 Surface Analysis System      39 

Choosing an Analysis 

Position 

Moving the Stage 

 The stage can be moved to a position of interest by double-clicking 

on either the platter view or the TTL view. Fine positioning should be 

done from the TTL view. Align the cross-hairs with the feature of 

interest. This sets the X & Y co-ordinates. Use the Z+ and Z- buttons 

to bring the surface into focus.  

 Getting the sample at the correct height is crucial to ensure that the 

sources and analyser are pointing at the correct feature. There are 

two ways of doing this, automatically and manually. 
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40      Choosing an Analysis Position   |   Setting the Sample Height: Auto-Height for Point 
Analysis 

Setting the Sample Height: Auto-Height for Point 

Analysis 

 For large area analysis on larger uniform samples e.g. > 5 mm in 

size, using the 400 µm X-ray spot, it is recommended to use the Auto 

Height option in the Point object after the analysis position has been 

defined. This sets the sample position on the z-axis using the XPS 

signal at a particular energy (the default is 530 eV binding energy, as 

defined in the Spectrum tab).  

 There are two modes of operation of the auto-height option; Full or 

Relative range. Full mode measures the signal across all possible 

sample positions and is best used when points are defined whilst the 

samples are still in the load-lock. Relative mode uses the position 

defined when the point was inserted and measures the XPS signal 

+/- a given value above and below this position. Good default values 

for these two modes are shown below. The default settings can be 

defined by accessing the Stage Auto-Height page in Avantage 

preferences > Experiment Preferences. 

 

Figure 25: Auto Height Absolute Range 
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Figure 26: Auto Height Relative Range 

 

Figure 27: Experiment Preferences  
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42      Choosing an Analysis Position   |   Setting the Sample Height: Manual Height Setting 
for Point Analysis 

Setting the Sample Height: Manual Height Setting for 

Point Analysis 

 • For small feature analysis, the height may be optimised by using 

the Height Adjust camera. 

• Locate the feature using the Platter and Sample View images. 

• Adjust the sample height so Sample View image is approximately 

in focus. 

 

Figure 28: Sample View Image 

 
• Switch to Height Adjust image  

 • The different camera angle may change the appearance of the 

feature and you may need to adjust the lighting to get a clear 

image. 

 

Figure 29: Adjusting the Lighting  
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 • Adjust the height using the Z+ and Z- buttons until the cursor lies 

on the feature.   

• In the Height Adjust image, only the Z+ and Z- controls are 

enabled. 

 

Figure 30: Height Adjustment 

 The diagram below shows how this procedure operates.  The two 

cameras will only view the same feature when the sample is at the 

correct height. 

 

Figure 31: Camera Height Setting 
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44      Choosing an Analysis Position   |   Setting the Sample Height: Auto-Height for Line 
Scans 

Setting the Sample Height: Auto-Height for Line Scans 

 For line scans auto-height is enabled by clicking the checkbox on the 

Position tab of the properties panel. The mode can be set using the 

Auto Height tab. This is whether the height is measured just in the 

centre (1 point), at each end (2 points – the line will then have a 

calculated height at each point which fits a line between the two end 

heights), or at every point (good for rough surfaces). 

      

Figure 32: LineScan Control Properties 

Setting the Sample Height: Auto-Height for Areas 

      

Figure 33: Area Control Properties 
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Figure 34: Suitable Sample for 1 Point Auto-Height (Left). Suitable Sample for 3 

Point Auto-Height (Right) 
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46      Adding Analysis Areas to an Experiment   |   Setting the Sample Height: Auto-Height 
for Areas 

Adding Analysis Areas to an 

Experiment 
 Select the analysis type from the drop-down menu in the optical view 

toolbar. There are 6 options available: 

Point A single point. This is the standard mode of operation. 

Auto-analysis A single point enabled for auto-analysis mode. 

Multi-point Allows several points to be added. The same spectra will be collected 

at each point and will be stored in the same set of data files for easy 

comparison. 

Depth-profile A single point with a depth profile object. 

Line A line scan object. This is added by clicking and dragging to define 

the start and end of the line on the optical view or platter view 

Area An area is used to create an XPS image of the surface. It is created 

by clicking and dragging a rectangle on the optical view or platter 

view. 

 

Figure 35: Analysis Types 

 Once the analysis position has been found, the actual analysis area 

needs to be defined. This is done by holding down either the Ctrl or 

Shift keys and clicking with the left mouse button at the point on the 

optical view, SnapMap view, or platter view you wish to analyse (for 

areas or lines, click and hold the left mouse button at the start point, 

and then drag to the end point and release the mouse button). 

 • Use  left click to insert an analysis object with a new X-ray 

spot size. 

• Use  left click to insert an analysis object under the currently 

selected X-ray spot size in the experiment window. 
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2x Ctrl clicks – points under 2 sources 2x Shift clicks – points under the same 

source 

Figure 36: Inserting an Analysis Object 
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48      Adding Analysis Areas to an Experiment   |   Moving Points, Lines and Areas 

Moving Points, Lines and Areas 

 Click on the point and drag it to the new position. 

Click and drag on the end or corner of the Line or Area to resize a 

line of area. 

Click and drag away from an end of edge of a line or area to move 

without resizing. 

Deleting Points, Lines and Area 

 Select the object in the Experiment tree and press the <Delete> key. 

Point Settings 

 

Figure 37: Point Control Properties – Position Tab 

Defined Point Use X, Y, Z, Angle co-ordinates defined below for the analysis. 

Stored Point Use a stored position from the Optical View preset list for the 

analysis (e.g. “_Silver”). 

Save Video Image Stores a time-stamped .vgd of the optical view with the data when 

collected. Note that this happens every time the experiment is run, 

so multiple images will be stored. 

Optimise Region 

Acquisition Time 

Apportion the total experiment acquisition time between regions, in 

proportion to a function of the current measured Signal : Noise 
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Ratio (SNR) for each region. The SNR evaluation is carried out 

after all regions have completed a scan / snapshot. 

As the experiment progresses, the (remaining) regions with the 

highest SNR sequentially have no further scans or snapshots 

acquired. Near at the end of the experiment only the lowest SNR 

regions are still acquiring until all the original ‘total acquisition time’ 

has been used. 

Not available for multi-level experiments. 

Enable Auto-

Height 

Use the XPS signal to determine the best Z-position for acquisition. 

Enable Auto-

Analyse 

Activate Auto-Analysis for this point. No spectra need to be defined 

if this is clicked. Automatically activated if the point is defined as 

“Auto-Analysis” from the Optical View. 

 

Figure 38: Point Object – Auto Analysis Tab 

Show details Configure the Auto-Analysis experiment (see Auto-Analysis 

section). 

Show Interfering 

Peak Positions in 

Report 

Display red markers to highlight overlaps in the auto analysis 

report. 
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50      Adding Analysis Areas to an Experiment   |   Line Settings 

 

Figure 39: Point Object – Lighting Tab 

What to do with 

Analysis Lights? 

Chooses whether to leave the lights as set in the optical view, 

recall a stored setting, or turn the lights off. Note: this setting is 

ignored if a Raman spectrum is acquired, as the lights must be 

turned off. 

Read Light Levels Reads the current light settings from the optical view. 

Apply Light Levels Applies the saved light settings. 

Line Settings 

 

Figure 40: LineScan Control Properties 
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Read Start Define the current stage position as the first point of the linescan. 

Read End Define the current stage position as the last point of the linescan. 

Enable Auto-

Height 

Use the XPS signal to determine the best Z-position for acquisition. 

The settings on the Auto Height tab as described above determine 

how many points are used for the auto-height. 

Number of Points Number of points in the linescan. 

Step Size Distance between points in µm. 

Area Settings 

 

Figure 41: Area Control Properties 

Design mode Define the area by the step size between points, the number of 

points, or the area size. 

Auto-Height Use the XPS signal to determine the best Z-position for acquisition. 

The settings on the Auto Height tab as described above determine 

how many points are used for the auto-height. 

Video Image Save an optical image of the area to be mapped. If the area is 

larger than the camera field of view, a series of images will be 

collected and tiled to create an image of the area. The platter 

camera view is also saved in this case 

Auto Spot / Get 

Spot Size 

Optimises the X-ray spot size based on the step size. 
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52      Adding Analysis Areas to an Experiment   |   Multiplex Operation 

Read / Move Read in the current stage co-ordinates, or move to the defined 

position. 

 

  

Make Flat sets all of the Z coordinates to 

the same value. 

Make Planar takes three corner values and 

creates a sloping plane. 

Figure 42: Area Settings 

Multiplex Operation 

 The General settings for each object have an option called Multiplex. 

If this is selected, one scan for each element is collected, then the 

next scan is collected for each element until all requested scans have 

been acquired (unlike the standard mode of operation where all the 

scans for one element are collected before moving on to the next 

region). This can be advantageous if it is required to ensure that the 

X-ray dose is constant for all acquired data, rather than the first 

region acquired having minimal exposure compared to a long 

exposure for the last region acquired.  

 For X-ray sensitive samples it is probably better to collect low 

numbers of scans as a line scan or area and collapse the data, rather 

than operate in this way. 
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Configuring the Analysis Area by Setting the X-ray Spot 

Size 

 Once the positions are defined, the X-ray source size can be 

optimised to fit the analysis area. This is most easily done by 

selecting the Point (or Line or Area) object, clicking on the spot size 

control in the optical view, and using the mouse-wheel to adjust the 

X-ray spot to the desired size.  

 The X-ray spot is adjusted in 5 µm steps. The Nexsa is a source 

defined XPS instrument, and so the X-ray spot size defines the 

analysis area. 

 

Figure 43: Spot Size 

Enabling the Flood Gun for Insulator Analysis 

 For electrically insulating samples, activate the Flood Gun checkbox 

in the X-Ray property page to enable the use of the charge 

compensation system during the analysis. If you are unsure as to 

whether the source is required, it is best to turn the source on, as it 

will not adversely affect the analysis of a conductive sample. 

 

Figure 44: X-Ray Control Properties 
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54      Defining Spectrum Regions   |   Using the Multi-Spectrum Insert Tool (XPS) 

Defining Spectrum Regions 
 For Auto Analysis, spectra do not need to be defined as this will be 

done automatically as the experiment is run. Otherwise, for each 

analysis Point, Line or Area, the spectra to be acquired need to be 

defined. This can most easily be done using the Multi-Spectrum tool. 

The Multi-Spectrum tool is context-sensitive to the source that is 

being used, and options change depending on if XPS, ISS, UPS or 

REELS are being used. See the relevant appendices for details 

Using the Multi-Spectrum Insert Tool (XPS) 

 • Click on the Point object in the experiment tree that you wish to 

add spectra to and then select the Multi-Spectrum tool. 

 

Figure 45: Multi Spectrum Tool 

 • The Multi-Spectrum tool allows the selection of the element 

regions and survey spectra from the Periodic Table. Right-clicking 

on an element allows you to choose transitions other than the 

major peak to be inserted into the experiment (to account for 

potential overlaps with other elements for example).  

 • The Multi-Spectrum tool detects the source object above it, so 

that default scans for use with the UV source (He1 and He2), ISS 

and REELS can be added using the check box that appears in the 

“Survey” position. Please see the relevant sections for UPS, ISS 

and REELS for more details. 
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Figure 46: Inserting Multiple Spectrum into the Experiment 

 • The spectrum type should also be selected from the Multi-

Spectrum tool. Scanned spectra are best used for point analyses 

to get the best possible resolution. Snapshot spectra collect more 

quickly and are therefore best used for multi-level data sets such 

as line scans, areas, or depth profiles. SnapMaps are rapid 

images using snapshot spectra, scanned over 0.1, 0.5, 1, 2, or 3 

mm. 
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56      Defining Spectrum Regions   |   Selection of Pass Energy and Step Size 

Selection of Pass Energy and Step Size 

 The pass energy determines the energy resolution - a higher pass 

energy will give increased XPS intensity but with increased peak 

width.  Analysis is usually a compromise between energy resolution 

and sensitivity. 

 • Lens mode “Standard” should be used for XPS acquisition. Other 

lens modes are described in the relevant sections. 

• For survey spectra, a pass energy of 200 eV and step size of 

1 eV is suggested. 

• For higher energy resolution, narrow scan spectra a pass energy 

of 50 eV with step size of 0.1 eV is suggested.  Lower pass 

energies e.g. 20 eV or 10 eV may be required to get the ultimate 

energy resolution.  Often, the natural linewidth of the 

photoelectron line combined with the width of the X-ray source 

mean there can be little benefit in using a very low pass 

energy.  The intensity will be reduced but the observed peak 

width may not be significantly improved. 

• For snapshot spectra, as pass energy of 150 eV is recommended 

to ensure that the spectrum width is approximately 20 eV. In 

snapshot mode changing the pass energy changes the width of 

the spectrum as these two parameters are linked. 

• The acquisition parameters for each spectrum can be changed in 

the spectrum property page. All scans that are going to be 

quantified together must be collected at the same pass 

energy. It is best to set the parameters when the Multi-Spectrum 

tool is open so that they are applied to all region spectra inserted, 

but they can also be accessed by clicking on individual spectrum 

objects in the Experiment Tree. 

 

Figure 47: Scanned Spectrum Control Properties 
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 • The defaults for the survey spectrum, and all the spectrum types 

can be set in Avantage Preferences > Experiment Preferences 

> Multi-Spectrum Control. 

 

Figure 48: Workplace Preferences 

Gun Shutdown Object 

 After completing the set-up for an experiment it is good practice to put 

a Gun Shutdown object at the end of the experiment. This ensures 

that the sources are only running when needed and prolongs the 

lifetime of consumable parts such as filaments.  

 The Gun Shutdown object is accessed from the Sources object 

button at the top of the Experiment page. 
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58      Depth Profile Analysis   |   Gun Shutdown Object 

Depth Profile Analysis 
NOTE: For information on MAGCIS, please see page 78. 

 • Depth profile analysis is set up in a similar way to other 

experiments.  

• Use Multi-Spectrum to insert the spectrum regions. 

• For electrically insulating samples, check Flood Gun in the X-Ray 

property page. 

• The raster size of the ion beam sputtered area will be 

automatically optimised relative to the size of the X-ray spot.  The 

raster area is rectangular in shape, with the short side in the y-

direction, and the long side in the x-direction. The Raster Size 

control sets the short dimension; for example setting a 1 mm 

raster will generate an etch crater with dimensions 1 x 2 mm. By 

default the raster is automatically set to be 5x the X-ray spot size 

with a minimum value of 1 mm.  

• Select the Ion Energy and Current in the Depth Profile > Ion 

Gun page. 

 

Figure 49: Depth Profile Properties. Ion Gun Tab 

 • Select the number and length of etch periods in the Depth 

Profile > Profile page. 
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Figure 50: Depth Profile Properties. Profile Tab. 
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60      Depth Profile Analysis   |   Gun Shutdown Object 

Delay after etch If the sample is an insulator, this value is used to allow a delay for the 

charge compensation to rebalance after etching before acquisition. 

10 s is a common value. 

Rotation If the rotation holder is being used, then the sample can be rotated 

during etching to improve the possible depth resolution. Azimuthal 

rotation requires acquisition to be at the centre of the axis of rotation 

(standard position _Centre of Rotation in the optical view), and 

allows minimum etch times of 10 seconds. Compucentric rotation 

allows profiling off the rotation axis. In this mode the minimum etch 

time is 30 seconds. 

Multi-Phase 

etching 

This allows the etch time per level and the number of rotations to be 

changed during a profile. 

• Insert – adds a new line into the table 

• Append – adds a new line at the end of the table 

• Delete – removes the selected line from the table. 

 After changes have been made, Apply must be pressed to action the 

changes. 

 

Figure 51: Depth Profile Properties. Etch Phases Tab 

 • When the experiment is run, the argon gas valve will be 

automatically opened, and the source will be turned on. It is left in 

Blanked mode (yellow status light) until required to etch (green 

status light). 
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Collecting Data 

Select Where to Store the Data 

 Data is stored in the folders defined by Project Root\Project 

Name\Experiment Name. This is entered on the Experiment object 

properties page. The experiment name can be entered either on the 

General tab, or by clicking twice slowly on the Experiment object in 

the Experiment Tree (as would be done to rename a file in 

Windows). 

     

Figure 52: Experiment Properties Tabs 

 The data is stored in a file structure based on the Experiment Tree 

structure, with each object being a folder, and the spectrum data files 

being stored a folder based on the name of the object they are 

attached to. Typically this would be something like C:\Project 

Root\Project Name\Experiment Name\Source\Point. 

Running the Experiment 

 The experiment is started using the Run Experiment icon, or from 

the Run menu. Either the entire experiment can be run or a part of 

the experiment from the currently selected object in the Experiment 

Tree. 

 
Run complete experiment 

 
Run experiment from selected step 
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62      Collecting Data   |   Disabling Experiment Steps 

 • When the experiment is run, the required guns are switched on 

with the requested parameters.  On rare occasions, this may take 

a few minutes to ensure the guns are providing the requested 

parameters.  If the X-ray or flood gun does not produce the 

requested parameters in the usual time (~ 30 seconds), a gun 

conditioning routine may be automatically started, indicated by a 

yellow status indicator.  When the gun is operating correctly, the 

experiment will continue. 

Disabling Experiment Steps 

 While the experiment is running, steps can be disabled by selecting 

an object and either pressing the space key on the keyboard, or right-

clicking on the object and deselecting Enabled on the menu. The 

object, and any child objects attached to it will change to a grey 

colour, and the legend (Disabled) will be displayed. It is not possible 

to re-enable objects while an experiment is running. This procedure 

can also be used before an experiment is run to prevent existing data 

being overwritten.  

            

Figure 53: Disabling Experiment Steps 
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Auto Analysis 
 Auto Analysis is designed to be used to automatically acquire a 

survey spectrum, analyse to determine which regions are present and 

then acquire higher energy resolution spectra for those regions. It 

then analyses these regions to provide a simple chemical state 

assessment. The results are reported into a report document. 

 An Auto-Analysis experiment requires an X-ray source and Point 

object with Enable Auto-Analyse checked. It is recommended that 

Enable Auto-Height is also checked. 

 

Figure 54: Enable Auto-Height and Auto-Analysis 

 Usually, optimum analysis will use a larger X-ray spot and typically 

400 µm for Nexsa. 

 

Figure 55: AutoAnalyse Turned On 

 When the experiment is run a survey spectrum is automatically 

inserted. The acquisition conditions are those defined for the Multi-

Spectrum tool, defined in the Edit > Preferences. 
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64      Auto Analysis   |   Disabling Experiment Steps 

 

Figure 56: Workplace Preferences. MultiSpectrum Control 

 After analysis of the survey spectrum, the detected regions are 

inserted and the survey spectrum is disabled.  
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Display and Processing of 

Data 
 • Open a new processing grid . 

• After the experiment has started to acquire data, Drag and Drop 

the data from the experiment tree into the processing grid. 

 

Figure 57: Dropping Data into the Processing Grid 

 • All of the data below a branch of the tree is copied into the 

processing grid. 
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66      Display and Processing of Data   |   Disabling Experiment Steps 

 

Figure 58: Data Copied to the Processing Grid 

 • As the data is acquired the spectra will be updated. 

• For further information about data display and processing, see the 

Processing section of the Avantage Help manual (a glossary of 

the commands available is listed in Appendices 1 & 2, page 141). 
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XPS Knowledge View 
 The Knowledge Viewer provides useful information to aid analysis of 

XPS data.  It can be started from the icon on the left side of the 

screen, from the menu bar select Windows > Open > XPS 

Knowledge View, or from a region spectrum and right click Show 

XPS Knowledge for this spectrum 

      

Figure 59: Showing XPS Knowledge View 
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68      XPS Knowledge View   |   Disabling Experiment Steps 

Figure 60: XPS Knowledge View 

 The Knowledge Viewer opens in a tabbed document. As for all 

tabbed documents, the tab may be dragged and dropped onto the 

document to split it into a separate pane. 

         

Figure 61: Knowledge Viewer Tab 

 
Many of the pictures in the document have links to vgp files. These 

are shown by the cursor changing to a hand pointer. 

 Click on the picture and this will open the Avantage processing vgp 

document. 

The Periodic Table button can also be used to select an element. 

 

Figure 62: Periodic Table 
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Maintenance & 

Troubleshooting 
 IMPORTANT: 

The Nexsa system has no user serviceable parts. If the 

instrument has a problem, please contact your local service 

support team for advice. This section is primarily for information 

and should be used with the guidance of a service 

representative. 

Vacuum Details Window 

 The vacuum details window shows the status of the vacuum system, 

and contains routines for flushing gas lines, and baking the system. 

Only routines that are required for regular use of the instrument are 

described here, and other controls should not be used unless guided 

to do so by a support engineer. 

 

Figure 63: Vacuum Diagnostics Window button 

1213765/C - Production



 

70      Maintenance & Troubleshooting   |   Vacuum Details Window 

 The first page shows the vacuum schematic, the status of the valves 

and pumps, and the option fitted. The schematic is interactive, and it 

is not recommended to click on controls unless guided to do so by a 

support engineer. 

 

Figure 64: Vacuum Schematic Window 

(layout seen depends on the options fitted) 
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 The second tab shows the detailed vacuum status. This page 

contains controls for pumping the argon gas line (and helium gas line 

if fitted). This should be done after a gas bottle is exchanged, to 

ensure that clean gas is used by the instrument and prolong the life of 

consumable parts. 

 

Figure 65: Vacuum Detailed Window 

(layout seen depends on the options fitted) 
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72      Maintenance & Troubleshooting   |   Vacuum Details Window 

 The TSP Control page shows the status of the titanium sublimation 

pump. The pump runs automatically, and there is no need to operate 

the controls on this page in normal operation. 

 

Figure 66: TSP Control Window 
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 The Miscellaneous tab contains troubleshooting and diagnostic 

controls and is for engineer use only. 

 

Figure 67: Miscellaneous Window 
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74      Maintenance & Troubleshooting   |   Ion Gun alignment and calibration 

Ion Gun alignment and calibration 

NOTE Alignment of the ion gun should only be done if requested to do 

so by a service and support engineer. In typical use of the 

system it is not necessary to realign the ion source except after 

the system has been vented for maintenance. 

 Before starting the procedure, it must be checked that the standard 

aperture positions are correct, and that the gas lines are purged and 

connected to the gas supply. To align the ion gun, open the ion gun 

details page, and choose the Filament tab. From this page several 

option are available to align the currently selected mode, all 

monatomic or cluster modes, or all modes. 

 

Figure 68: Calibration routine page on ion gun details window 
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Spectrometer Calibration 

 

The Nexsa calibration tool contains full instructions on how to run 

procedures. Most routines are designed for authorised service 

personnel, but there are tools that are for routine calibration of the 

instrument and also for assisting with troubleshooting. 

Spectrometer energy scale and transmission function calibration 

 To calibrate the spectrometer, open the calibration software, and 

choose the Spectrometer tab. Select Energy Scale/Tx 

Fn/Performance Specs and press Run. This will take around 30 – 

60 mins to run, and will calibrate the spectrometer and measure the 

instrument performance. It is recommended to run this process once 

per month. 

 

Figure 69: Spectrometer calibration page 

Log files 

 The Troubleshooting tab in the calibration software contains 

routines to collect the logfiles if requested by a support engineer. 
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76      Maintenance & Troubleshooting   |   Software Reset 

Software Reset 

 

If Avantage fails to respond, the software should be closed using the 

Windows Task Manager. The ServerStopper program (found in the 

Thermo Avantage group on the Windows Start menu) should be run 

before Avantage is restarted. 

Full System Reset 

 If it is necessary to restart the Nexsa system (as advised by your 

local authorised technical support team), the PC must be shut-

down first.  

 The main power switch at the back of the Nexsa should be turned 

Off, and turned back On after a delay of at least 30 seconds. The 

system will automatically run the PLC recovery routine, which will 

ensure all the hardware is running correctly. The PC can then be 

restarted. When Windows has restarted, drivers may reload 

automatically. It is also advised to recalibrate the detector. This is 

done by loading the 1D Detector Toolkit software from the Thermo 

Avantage group on the Windows Start menu and clicking the 

Calibrate button on the lower left side of the screen. Avantage can 

then be restarted. The detector calibration procedure should also be 

used if the power has been interrupted to the instrument. 

 

Figure 70: Main power switch 
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Optional Accessories 

 
 The following sections detail the use of the analytical options and the 

optional sample holders for the Nexsa instrument. 
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MAGCIS 

 

 

Introduction 

 The MAGCIS gun (Monatomic And Gas Cluster Ion Source) is used 

as a dual purpose ion source for sputtering and depth profiling. 

 It can be used as a conventional ion gun, using Ar+ ions, or to 

produce Ar cluster ions. Cluster ions are typically used for sputtering 

more delicate materials such as organic and polymer materials. The 

higher mass of the ion means the average energy per atom is lower 

and so less damaging. 

 

Figure 71: Schematic of MAGCIS  
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 Inorganic materials are not effectively sputtered using the cluster 

source and usually require use of the monatomic source.  Switching 

between operating modes is controlled through software. 

 Experiment objects provide controls to switch the mode between 

monatomic and cluster ion operation. Changing the operating mode 

to cluster changes the ion gun operating parameters and selects an 

increased pressure of argon gas through the supersonic nozzle, to 

enable cluster ion formation. The bend in the gun after the ionization 

and extraction region eliminates neutrals and requires use of an 

electromagnet to deflect the ion beam. This also provides a method 

to select cluster size. 

 In monatomic mode, argon gas is introduced into the normal 

ionization chamber. In cluster mode, argon gas is introduced through 

the nozzle. 

 Avantage is used to control the source, the gas valves, and 

differential pumping based on the selection of operating mode. In 

normal operation the Depth Profile or Ion Etch experiment objects 

will be used. 

Selection of Operating Parameters 

 The source operates in exactly the same way as the standard EX06 

ion gun (as detailed on page 58). MAGCIS adds the extra control for 

using either monatomic or cluster mode. 

Monatomic or Cluster? 

 Use of Ar clusters is usually restricted to polymer or organic based 

materials as Ar clusters do not effectively sputter inorganic materials 

where the bond strength is larger. 
 

Monatomic mode Cluster mode 

Energy applied 500 eV- 4000 eV 2000 eV - 8000 eV 

Atom size 1 75- 2000 

Energy per atom 500 eV- 4000 eV 1 eV - 100 eV 

Typical samples 
for cleaning 

Metals, metallic compounds, 
semiconductors 

Glasses, ceramics, metal oxides, 
polymers, fibres, semiconductors 

Typical samples 
for profiling 

Metals, metallic compounds Metal oxides, polymers, mixed oxide  
and polymer layers 
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Monatomic Mode 

 The monatomic modes are defined with ion beam energies in the 

range 500 – 4000 eV. When using monatomic modes, selecting a 

lower ion beam energy will be less damaging but the lower ion beam 

flux and lower energy will result in a reduced sputter rate. 

 The monatomic beam modes allow selection of a beam current – 

either Low or High.  The “Low” setting is designed to be 3x lower than 

the “High” setting to maintain the same sputter rate when using 

compucentric rotation. 

Cluster Mode 

 When using a cluster mode, the ion beam energies are higher than 

used in monatomic mode, in the range 2000 – 8000 eV. A lower ion 

beam energy will usually reduce sample damage but at low energies, 

there may also be very little sputtering. The cluster mode allows 

selection of a cluster size – 75-2000 atoms. 

 For a given cluster ion beam energy, the average energy per atom is 

higher for the small cluster mode and sputter rate will be higher. In 

the absence of other information, a typical operating condition for 

routine use is 6000 eV, 1000 atom cluster size. 

Control in Avantage Experiments 

 Control of the ion gun in an Avantage Experiment uses the usual 

Depth Profile and Ion Etch experiment objects, as described in the 

section Depth Profile Analysis, page 58. 

 The Mode drop-down menu allows selection of Monatomic or 

Cluster mode. Users may then select the Ion Energy and Beam 

Current (monatomic modes) or Cluster Size (cluster modes). 

  

Figure 72: Depth Profile Object. Ion Gun Monatomic and Cluster Mode 
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 Sputter rate for monatomic modes is calculated based on known 

sputter rates for Ta2O5 at different beam energies. The rate is 

adjusted using the actual optimized beam current obtained during the 

automatic beam mode setup sequence. Cluster etch rates are heavily 

dependent on the material being analysed, and so it is recommended 

to calibrate the sputter rate by analysing a standard of known 

thickness if possible. 

 The status of gas valves can be viewed from the Vacuum Details 

page. Users with Avantage Engineer access may also open and 

close valves. 

 

Figure 73: Example Vacuum Details Control with MAGCIS 
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 When using cluster mode, argon valve V63 is open to allow a higher 

pressure of gas through the supersonic nozzle to allow adiabatic 

expansion and consequent cooling and condensation of the argon 

gas to form clusters. The above diagram shows the schematic layout 

on Nexsa instrument. V64 is opened to provide additional differential 

pumping. In monatomic modes, gas is introduced through a fixed leak 

valve directly into the ionization chamber. This mode is similar to 

conventional ion guns such as the EX06.  

 It is advisable to periodically check operation and alignment values to 

ensure optimum operation. This can be done using the ion gun 

details window, as described in the main body of the manual 

(Maintenance & Troubleshooting). 
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UPS 

Overview 

Introduction 

 UV photoelectron spectroscopy (UPS) is a related technique to XPS. 

Instead of X-ray photons, ultra-violet radiation is used to generate 

photoelectrons from the sample. These are in the kinetic energy 

range 0-50 eV, and correspond to the valence electrons, those that 

are involved in bonding. 

As the process is the same as XPS, signal generated by the X-ray 

source will impact on the UPS data being collected, and so the X-ray 

source should be turned off when collecting UPS data. However, it is 

not necessary to turn off the UV source when collecting XPS data, as 

the UV photoelectrons are too low in energy to affect most XPS 

analysis. 

More information on UPS can be found at www.xps-simplified.com. 

 

Introduction for UPS Operation  

Flush/Prime the Gas Lines 

 It is important to prevent contamination of the UV source by using 

high purity research grade inert gas (99.999% pure helium, although 

other inert gases may be used) connected from the bottle regulator at 

approximately 1 bar (2 bar maximum) input pressure by clean 

stainless steel 6 mm pipe to the compression fitting on the service 

panel of the system (see Figure 74). 

         

Figure 74: Service Panel Helium Input Connector Before and After Connecting 6 mm 

Metal Helium Line 
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 It is recommended that the internal gas lines to the UV source are 

pumped and flushed with helium prior to operation, to prevent 

contamination of the UV source. This operation is automatically 

performed by pressing the Flush He Gas Lines button on the 

vacuum details page (Figure 75), which alternately opens V10A and 

V10B (Figure 76) to pump and recharge the gas supply line to the 

UV lamp; the pump and flush is repeated three times and takes 

approximately 2 minutes to complete. The final step flushes the 

backing line with argon to remove any remaining helium that may 

slow pumping performance. The UV source is then ready to use. It is 

recommended that another flush cycle is be performed before using 

the source if it has not been used for more than a few days. 

 

Figure 75: Avantage – Vacuum Diagnostics Page 
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Figure 76: Gas Pumping V10A and He Gas Supply Valve V10B are Alternately Opened 

During Pump and Flush 

Run the Source and Acquire UPS Data from the Avantage Experiment 

 UPS spectra may be acquired from the Avantage 

experiment/acquisition pane, with automated source control. This 

may be used as a series of XPS/UPS and depth profile experiment 

objects to allow programmed UPS control. 

IMPORTANT 

The X-ray source will produce photoelectrons that will impact the 

collected UPS spectrum. The X-ray source must be turned OFF when 

collecting UPS data. It is not generally necessary to turn off the UV 

lamp when collecting XPS data. 
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 1. Start a new experiment from the Avantage file menu 

 2. Click on the Sources icon (Figure 77) and select UV Source. The 

source settings for He I / He II may be selected at the Source 

Properties page in the lower pane (Figure 78), together with 

enabling the flood gun for insulator analysis, and the sample bias 

if the sample bias stage is being used. 

 

Figure 77: Sources icon 

 

Figure 78: Sources Properties Page 

 3. Add a sample position ‘Point’ to the UV Source object (Figure 

80), and a spectrum acquisition object using the Multi-Spectrum 

Tool (note only the UPS He Survey control is used for UPS), 

which will use the default parameters. 
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Figure 79: Multi-Spectrum Tool for He I and He II sources 

  

 

CAUTION 

Beware that using pass energy of greater than 4 eV when using 

He(I) may lead to extremely high count rates at the electron 

detector which can rapidly age the detector channel-plates and 

could require their premature replacement. 

 

         

Figure 80: Example of UPS experiments with default parameters 
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 Example data for standard samples can be found in the data 

collected during system installation and at www.xps-simplified.com. 

The UV source will remain on at the end of acquisition unless a Gun 

Shut-down object is added to the acquisition tree, from the sources 

drop-down menu (Figure 81). 

 

Figure 81: Adding Gun Shutdown Object 

UV Source Details Page 

 The source control details page is accessed from the Avantage 

sample tab and clicking the “UV Source” icon on the drawing of the 

system: This is only required for troubleshooting / engineer usage. 

 

Figure 82: Avantage Source Control 
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Troubleshooting 

 If the source will not light, then it is advised that the following checks 

are made: 

 1. Communications between Avantage and the UV Power supply 

are good (no red indicator on the status bar). 

2. The vacuum trip has been reset (Details page, Trips page and 

press Reset). 

3. Pure Helium is connected to the system at 1 bar, with no leaks on 

the metal line. 

4. The gas lines have been pumped and flushed using the Flush He 

Lines procedure. 

5. The UV high voltage source cable is connected to the UV lamp. 

 If He I mode operation lights without problems but He II operation 

does not stay lit, then it is likely that the He II regulator is set too low. 

This is located behind the panel above the entry-lock, which can be 

removed by sliding upwards. Increase the regulator setting in steps of 

0.01 MPa (0.1 bar) by lifting the black adjustment knob on the top of 

the regulator and turning clockwise and re-test He II operation. If this 

does not achieve stable He II operation then refer to Thermo Fisher 

Scientific support contacts. 

 

Figure 83: He II regulator location 
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ISS 

Introduction 

 Ion scattering spectroscopy (ISS, also known as LEIS – low energy 

ion scattering) is used to obtain elemental information from the first 

atomic layer of the surface. It uses noble gas ions, typically He+, 

which are directed at the surface from the ion gun, and the scattered 

ions are detected by the hemispherical analyser. To do this, the 

analyser runs in the opposite polarity to when collecting electrons, so 

that positively charged ions collected at the detector. More 

information can be found at www.xps-simplified.com. 

The extreme surface sensitivity means that samples must be clean to 

detect the actual surface and not any surface overlayers which may 

be present. 

Ion scattering spectroscopy (ISS) operation on Nexsa is fully 

automated. This section describes preparing the system for ISS and 

how to collect ISS data. The same procedures apply whether the 

EX06 or MAGCIS ion sources are fitted. This section will be based 

around using helium, but ISS can also be collected using neon or 

argon by connecting to those gases to the helium input.  

Preparing for ISS Operation  

Flush/Prime the Gas Lines 

 It is important to use high purity research grade inert gas (99.999% 

pure helium) with the ion source to prevent premature failure of the 

filaments. The gas should be connected from the bottle regulator at 

approximately 1 bar (2 bar maximum) input pressure by clean 

stainless steel 6 mm pipe to the compression fitting on the service 

panel of the system (see Figure 84). 
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Figure 84: Service Panel Helium Input Connector 

 The internal gas lines to the ion source need to be pumped and 

flushed with helium prior to operation. This operation is automatically 

performed by pressing the Flush He Gas Lines button on the 

Vacuum Detailed page of the Vacuum Details window (Figure 85) to 

pump and recharge the gas supply line to the ion source. The pump 

and flush is repeated three times and takes approximately 2 minutes 

to complete. 

 

Figure 85: Vacuum Detailed Page 
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ISS system calibration 

 To ensure the best quality data it is advisable to calibrate the ion 

source if it has not been used for ISS recently, or if the system has 

been vented for a service. There are two steps to this procedure. The 

first is to align and focus the ion beam (as described in the 

Maintenance and Troubleshooting section), the second measures the 

ion beam energy to enable calibration of the peak positions. The 

second routine also checks the scattering angle, and both this 

parameter and the ion beam energy are stored with collected spectra 

for offline processing. 

 Align and focus the ion beam 

Open the ion gun details page, and select the Filament tab. Choose 

ISS from the Auto Setup drop-down menu, and click Run. 

 Measure the ion beam energy 

Open the ion gun details page, and select the Filament tab. Click 

Calculate in the ISS Source Energy section 

 

Figure 86: Ion Gun details page, Filament tab, with ISS controls highlighted 
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Collecting ISS Data using the Nexsa System 

 Collecting ISS data follows a very similar procedure to collecting XPS 

spectra. As with XPS, the structure is Source -> Position -> 

Spectrum. 

 To start, select ISS source from the Source menu above the 

experiment tree. This will insert the ISS Source object into the 

experiment tree. The properties page has settings to enable the 

charge compensation system (if the material being analysed is an 

insulator).  

 

Figure 87: ISS Source properties page 

 Define the position for analysis by adding a point, and then select the 

Multi-Spectrum Tool. In an ISS experiment, the survey object 

changes to be an ISS survey, and this should be inserted (currently 

the periodic table will not insert spectra with the correct parameters 

and should not be used). 
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Figure 88: Multi-Spectrum Tool in an ISS experiment 

 

Figure 89: A typical ISS experiment 
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 ISS is very surface sensitive, and the sample surface cleanliness is 

crucial in obtaining a good spectrum. It is also important to note that 

the He+ ion beam used for the analysis will slowly etch the sample, 

and so changes may be observed from scan to scan if layers are very 

thin (this is most frequently seen if there is an incomplete carbon 

contamination layer on the surface). 

Example data for standard samples can be found in the data 

collected during system installation and at www.xps-simplified.com. 

 After the acquisition has completed, the ion source is blanked. 

Turning off the source is controlled from a Gun Shutdown object. It 

is recommended that the ion source is turned off when not required. 
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REELS 

Overview 

Introduction 

 Reflected electron energy loss spectroscopy (REELS) operation on 

Nexsa is automated, under user instructions which are described in 

this section. REELS is a scattering technique, similar to ISS, but 

using an electron beam as the probe. It gives information on 

electronic properties and can be a help in understanding the 

contribution of loss-features to an XPS core level spectrum. More 

information can be found at www.xps-simplified.com. 

As REELS relies on detecting scattered electrons, it is important to 

turn off the X-ray source when collecting REELS data, as the XPS 

signal will be merged with the REELS results. 

Collecting REELS Data  

 Collecting REELS data follows the same procedure to collecting XPS 

spectra. As with XPS, the structure is Source -> Position -> 

Spectrum. 

 To start, select REELS source from the Source menu above the 

experiment tree. This will insert the REELS Source object into the 

experiment tree. The properties page has settings to enable the 

charge compensation system (if the material being analysed is an 

insulator).  
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Figure 90: ISS Source properties page 

 Define the position for analysis by adding a point, and then select the 

Multi-Spectrum Tool. In a REELS experiment, the survey object 

changes to be a REELS Survey, and this should be inserted 

(currently the periodic table will not insert spectra with the correct 

parameters and should not be used). 

Note that the elastically scattered peak has a very high count rate 

and so pass energies of 15 eV or less should be used to prevent 

aging the detector. The default pass energy of 10 eV is 

recommended. 

 

Figure 91: Multi-Spectrum Tool for REELS experiment 

1213765/C - Production



 

98      REELS   |   Collecting REELS Data 

 

Figure 92: A typical REELS experiment 

 After the acquisition has completed, the electron source remains on. 

High energy electron beams may damage sensitive samples and so it 

is recommended that the source is turned off when not required. 

Turning off the source is controlled from the checkbox on the source 

object of by using a Gun Shutdown object. 

 Example data for standard samples can be found in the data 

collected during system installation and at www.xps-simplified.com. 
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iXR Raman 

General Safety Information 

 The iXR Raman on Nexsa has been designed and certified to have a 

Class 1 rating. No accidental exposure to the Laser beam is possible 

if the correct procedures are followed when operating and servicing 

this option. The iXR Raman unit has a classification rating of 

Class 3B, however suitable interlocking and tool access has been 

designed into the integration of this unit onto the Nexsa system to 

classify the safety status of the total integrated system as Class 1. 

 

For detailed safety instructions read the Nexsa G2 Safety Manual 

1213766. 

CAUTION USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF 

PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY 

RESULT IN HAZARDOUS RADIATION EXPOSURE. 

Product Labels 

Letter Label Image Label Description 

A 

 

Avoid Exposure label 
for iXR unit  

B 

 

Power and Wavelength 
Description for iXR unit 
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C 

 

Exposure Caution label 
for iXR unit 

D 

 

Rating Label 

E 

 

Exposure warning 
when removed 

F 

 

Interlock override 
warning 

G 

 

Class 1 LASER rating 

 

Table 8: Product Labels 
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Product Label Locations 

 

Figure 93: Safety Label Locations – A 

 

 

 

Figure 94: Safety Label Locations – B, C, F 

A 

C B F 
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Figure 95: Safety Label Locations – E 

 

Figure 96: Safety Label Locations – F, D, G 

E 

F 

D 

G 
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Interlocks and Safety Covers 

 The iXR unit has a Class 3B Laser safety rating with internal 

interlocks present for this status, which can be found in the iXR 

Raman Spectrometer manual. This manual (iXR on Nexsa) details 

the additional interlocks present when integrating the iXR unit onto 

the Nexsa system. These additional interlocks increase the Laser 

safety rating of the combined item to Class 1, by preventing the Laser 

beam from the iXR system from exiting the Nexsa system and 

ensuring that the iXR unit can only be run once positioned in place on 

the Nexsa. 

 The additional interlocks take the form of both direct (in circuit) and 

indirect (via PLC) controls. In some cases double-redundancy is 

introduced via combination of direct and indirect switching.  

 

Figure 97: Interlock Wiring Schematic 
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Interlock Details 

Switch Type Activation Details Circuit Details 

S1 NO Physically activated contact 

switch. Closed circuit only when 

primary gate valve is closed. 

Switches IP1 of PLC. 

S2 NO Physically activated contact 

switch. Closed circuit only when 

primary gate valve is in closed 

position. 

Direct activation/deactivation of 

Raman interlock switch. 

S3 NO PLC activated normally open 

relay, situated on Nexsa status 

panel. 

Activates to closed condition only 

when ALL of the following are all 

true: 

• IP1 is closed circuit. 

• IP2 is closed circuit. 

• Vacuum system is pumped 

down (turbopump at speed). 

• Avantage software is open on 

the PC, and communicating 

with the PLC (Comms OK). 

• Status panel is connected to 

the PLC. 

Direct activation/deactivation of 

Raman interlock input circuit 

based on these 4 conditions. 

Interlocks against turning on 

Laser if the unit is not located on 

the system or when the system 

is vented for engineer tasks. 

If the Status panel is 

disconnected from the PLC, 

power is lost to the relay and it 

will become open circuit 

automatically. 

S4 NO Coded magnetic switch. 

Closed circuit when Raman unit is 

correctly located in position. 

Direct activation/deactivation of 

Raman interlock switch. 

S5 NO Coded magnetic switch. 

Closed circuit when Raman unit is 

correctly located in position. 

Switches IP2 of PLC 

 

Table 9: Interlock Details 

 In the case of any of the above switches being open circuit, the 

Raman Interlock output (OP1) is also open circuit and the Laser is 

therefore deactivated and prevented from turning on, within the iXR 

raman unit. The combination of interlocks within this circuit prevents 

accidental exposure to the Laser beam, if all engineer procedures 

are followed correctly. 
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Introduction 

 The iXR Raman option on Nexsa is an assembly for recording 

Raman measurements on samples within the Nexsa system, 

consisting of four main parts: 

 1. Ultra-High Vacuum (UHV) lens assembly, mounted on the Nexsa 

system. 

2. iXR Raman spectrometer. 

3. Laser and Raman scatter beam path assembly. 

4. Interlocks and Beam Exposure prevention measures. 

 The complete spectrometer assembly is aligned such that the Raman 

measurement area and position are matched to the smallest x-ray 

spot on the Nexsa system. This allows concurrent Raman and XPS 

measurements to be conducted if desired.  

 The iXR Raman unit parameters are controlled through Thermo 

Scientific OMNIC™ software, and data collection capability is 

provided through the Thermo Scientific Avantage™ software. 

Electrical Connections 

 

Figure 98: Electrical connections 

 1. Accessory connection 

2. Illuminator output 

3. DC Power Input  (12V DC, 100W) 

4. Laser lockout safety keyswitch 

5. USB PC interface connection 

6. Interlock input connections 

6 

1 

2 

4 3 5 
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NOTE: The Interlock input connector A must be connected to the 

Nexsa cable TG1420-2 in order for the user to be fully 

protected from Laser exposure. Do not override this interlock 

at any time. 

Illuminators 

 There are three illuminators, located both on the top of the iXR unit 

on the main illumination display panel, and on the electrical 

connections panel on the side of the unit above the electrical 

connections.  

 

Figure 99: Illuminators 

 a. Power  

• Illuminated when system is turned On. 

b. Laser On 

• Illuminated when Laser is operating (On). 

c. Beam at sample display 

• Illuminated when beam is being transmitted out of the Raman 

unit. 

• Off when beam is being blocked inside the unit. 

Operation 

 All operations such as turning the Laser on/off and setting 

experimental parameters are completed using the Thermo Scientific 

OMNIC for Dispersive Raman (OMNIC) software.  

 Data collection can be completed using Thermo Scientific Avantage 

software, but the experimental parameters and Laser power must be 

set up in OMNIC prior to collecting via this method, and OMNIC must 

remain open during all data collection operations. 

OMNIC For Dispersive Raman (OMNIC) 

 OMNIC for Dispersive Raman is started from the Windows™ Start 

Menu. 

a c b 
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Figure 100: OMNIC for Dispersive Raman 

 Once clicked, OMNIC will open and the Raman unit will reset ready 

for operation. This involves resetting of some motors and other 

operations; as a result OMNIC startup may take up to 2 minutes. 

 If the Raman unit USB connection or power is not present during 

OMNIC startup, you will get an error stating that the unit is not 

available. Operation of the unit is not possible until the connection is 

restored and the OMNIC software is restarted. 

OMNIC Main Screen 

 OMNIC has one main screen which all functions can be accessed 

from, either through shortcut buttons or the File menu. Details of the 

individual functions can be found within the OMNIC Help file, but the 

most commonly used functions are highlighted in this section. 

 

Figure 101: OMNIC Main Screen 

 1. Save. 

3 1 2 
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Clicking this button saves the currently selected Raman 

spectrum, displayed in red in the active window. 

NOTE: No spectra are saved unless specifically directed to by the user, 

unless the automatic file saving is activated in the Collect 

experimental parameters. 

 2. Experiment Setup. 

This button opens a dialog box which allows control and setting of 

all experimental parameters, including Laser power and ON/OFF 

control. There are multiple tabs on this dialog box, the number of 

which varies depending on the software components installed.  

• Collect tab provides access to changing experiment collection 

parameters (see Defining Collection Parameters page 111).  

• Bench tab provides access to Laser parameters but also 

provides a real-time preview of the Raman spectrum from the 

sample using the current collection parameters. 

Experiment Setup dialog can also be accessed through the File 

menu by clicking Collect > Experiment Setup or by keyboard 

shortcut, CTRL + E. 

 3. Collect Sample. 

Clicking this button collects a Raman spectrum using the currently 

saved experimental parameters. 

This method is also accessible from the File menu by clicking 

Collect > Collect Sample, or by keyboard shortcut CTRL +S. 

Switching the Laser On 

 1. Open the Experiment Setup dialog. 

2. Switch to the Bench tab (Note: There may be a slight delay 

while the spectrometer adjusts ready for collection). 

3. Click the drop down bar in the Laser row of the parameter table. 

Select On. 

NOTE: If the drop-down bar button is not visible, double-click Off to 

display. 
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Figure 102: Experiment Setup Window 

 4. The Laser will turn on. A pop-up dialog will appear counting down 

the time to readiness. Once this has disappeared the unit is ready 

to use for data collection. 

5. Close the Experiment Setup dialog by clicking OK (unless other 

experimental parameters, e.g. Laser power, are being setup at 

the same time). 

NOTE: The Laser will not turn on if any interlock is in the open state – 

interlock status is shown in one of the icons above the 

Parameter/Value table, as shown in the image below. 

Switching the Laser Off 

 This operation is the same as switching the Laser On, but select Off 

from the drop-down bar. The Laser will switch off immediately once 

this is selected. 
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Figure 103: Switching the Laser Off 

 The Laser is a consumable component. It is recommended that the 

Laser be turned off whenever the spectrometer unit is not being used 

for data collection. 

Setting the Laser Power 

 The output Laser power can be set to any value in 0.1 mW steps up 

to the maximum power specified for the Laser being used. The 

maximum power will be displayed within the OMNIC software, which 

will automatically detect the Laser type being used. 

Laser name Wavelength (nm) Maximum power (mW) 

455 455 6 

532 532 10 

785 High Brightness 785 24 
 

Table 10: Laser Wavelength and Maximum Power 

 1. Open the Experiment Setup dialog and switch to the Bench tab. 

2. Double-click in the Value column of the parameter Laser Power.  

3. Type a Laser power and hit the return key. The stated Laser 

power will be set immediately. 

 Alternatively use single mouse clicks on the Up/Down arrows to the 

right of the Laser power number to adjust the Laser power in small 

steps. The power will change on each click. 

 

Figure 104: Adjusting Laser Power Using Arrows 

Choosing an Aperture for Data Collection 

 The iXR Raman Spectrometer unit has four apertures at the entrance 

to the Raman spectrometer; two slits (25 µm and 50 µm wide), and 

two pinholes (25 µm and 50 µm diameter). Changing the aperture 

varies the amount of Raman light collected by the spectrometer from 

the sample, therefore changing intensity and resolution of the Raman 

signal processed.  

 For the Nexsa system, best results are usually obtained by using the 

50µm pinhole. This maintains a reasonable level of Raman signal 
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intensity while cutting out much of the scattered light from areas 

outside those desired from the sample surface. 

 To set the desired aperture: 

• Open the Experiment Setup dialog and switch to the Bench 

tab. 

• Click the drop-down arrow at the far right of the value column 

for the Aperture parameter. (Note: If drop down arrow is 

not visible, double-click in the value box to activate). 

• Select the desired aperture from the drop-down menu. 

 

Figure 105: Selecting the Desired Aperture 

Defining Collection Parameters 

 1. Open the Experiment Setup dialog. 

2. Switch to the Collect tab. 

 

Figure 106: Experiment Setup Collect Tab 

 3. The following table outlines the parameters available for data 

collection. 
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Parameter Explanation Comments 

Collect Exposure Time 
(sec) 

Collection time for each full 
spectrum frame. 

Shorter exposures of 1-2 
reduce the chance of 
cosmic ray events in 
spectra. 

Preview Exposure time 
(sec) 

Collection time for each full 
spectrum in the Bench tab 
preview pane. 

Minimum is 1s. 

Sample Exposures Number of times the same 
full spectrum is collected. 

Total collection time is 
Collect Exposure Time x 
Sample Exposures. 

Shorter exposure times of 1-
2s and multiple exposures 
recommended (OMNIC has 
automatic cosmic ray 
removal if occurring in 
frames after the first). 

Final Format X-axis scale for data display Default is Shifted Spectrum 
(cm-1)  

Correction Indicates the type of 
spectrum correction applied 
prior to display. 

None – no processing. 

Fluorescence – corrects for 
backgrounds due to sample 
fluorescence. 

 

Photobleach time  Refer to OMNIC Help File. Allows for stabilisation of 
samples prior to analysis. 

Preview Data Collection Refer to OMNIC Help File. None 

File Handling Refer to OMNIC Help File. Allows automatic saving of 
files. 

Background Handling Selects source for 
spectrometer dark-field 
correction. 

Use Smart Background 
recommended – the dark-
field background is collected 
and updated while the unit 
is on but in a passive state. 

Experiment Title Refer to OMNIC Help File. Recommend not changing. 

Experiment Description Refer to OMNIC Help File. Allows saving of description 
of experiment within the 
saved data file. 

 

Table 11: Parameters Available for Data Collection 
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 4. Click Save. 

NOTE: If Save is not clicked, then the parameters will be used for the 

current experiment run but will not be restored if OMNIC is 

restarted at any point. 

 5. Close the Experiment Setup dialog. 

Data Collection 

Data Collection Using OMNIC 

 1. Click the Collect Sample button within OMNIC.  

2. A dialog will appear asking for the experiment title to be entered. 

Default text is Date and Time (including timezone). The 

Spectrum Title is the data description text that will appear in the 

display window when the data is displayed, and can be changed 

at a later time if desired. 

 

Figure 107: Collect Sample Screen 

 3. Type the desired spectrum title and click OK to start data 

collection. 

4. Once data collection is complete you will get a message asking if 

the data should be added to the active display window. 

 

Figure 108: Confirmation Screen 

 5. Click Yes and the data will be displayed on the screen. 
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NOTE: Data is not automatically saved, so must be saved manually 

(unless the automatic saving has been set in the Collection 

parameters). 

Data Collection Using Avantage 

 1. Set up all experimental parameters (Laser On and power set, 

exposure times etc.) using OMNIC software. Leave the OMNIC 

software open but all dialog boxes closed. 

2. Ensure that OMNIC software has a data display window named 

“Window1”. If not then create Window1 by selecting Window > 

New Window from the file menu (or keyboard shortcut 

CTRL + N) and entering the title for the window in the dialog as 

“Window1”. 

 

Figure 109: New Window Screen 

 3. Set up an Avantage experiment for XPS as normal. 

4. Insert a Raman Spectrum object into Avantage at the point when 

the Raman spectrum is desired to be collected. 

 

Figure 110: Raman Spectrum Object 

NOTE: The Raman spectrum object must be inserted under a point 

object, as per XPS spectra. 

 5. Run the experiment. The Raman data collection will be 

undertaken at the specified point in the experiment. 

6. Data will be automatically saved with a Time and Date filename, 

in the same folder as the Avantage data for the same point. 
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Potential Factors Affecting Raman Data Quality 

 Some aspects of the Nexsa hardware setup may lead to a 

detrimental effect on Raman spectral data quality, and therefore must 

be considered when setting up a Raman data collection experiment. 

Factor Action Required 

OMNIC Data Collect Avantage Data Collect 

Light from charge 
compensation source 

Turn off flood gun manually. Insert Gun shutdown for 
flood source prior to Raman 
spectrum collection. 

Fluorescence under X-ray 
illumination 

Turn off x-ray source. Insert Gun shutdown for x-
ray source prior to Raman 
spectrum collection. 

Fluorescence under UV 
illumination 

Turn off UV lamp. Insert Gun shutdown for UV 
source prior to Raman 
spectrum collection. 

Light from Chamber LEDs 

Turn off chamber LEDs 
manually. 

(Note there are 2 LED light 
sources which could be 
turned on). 

No action required  

(LEDs will turn off 
automatically). 

 

Table 12: Factors Affecting Raman Data Quality 
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Changing Laser Wavelength 

 From time to time it may be beneficial to use different Laser excitation 

wavelengths for collecting Raman spectra. Two alternative Laser 

wavelength kits, 455 nm and 785 nm, are available to purchase. Each 

kit consists of Laser assembly, grating assembly and filter assembly 

for the wavelength quoted. This section details how to change 

between the different Laser wavelengths on the iXR Raman unit. 

 

For detailed safety instructions read the Nexsa G2 Safety Manual 

1213766. 

 1. Ensure that the existing Laser is turned off and the OMNIC 

software is closed. 

2. Ensure that system is switched off and applied is lock-out and 

tag-out. 

3. Remove the right rear dark grey cladding panel to gain access to 

the Raman unit. To do this, lift the panel upwards by 2 - 3 cm then 

pull the panel towards the rear of the system to disengage from 

the mounting points, then lift further and pull away from the 

system in both directions. 

 

Figure 111: Removing the Grey Cladding 

 4. Undock the existing Laser and remove. Set to one side. 

 

Figure 112: Undocking the Existing Laser 
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 5. Remove the cover of the iXR unit by loosening the four silver-

coloured fixing screws on the front and rear of the unit (note: 

screws are captive and sprung), then lifting the cover directly 

upwards.  

      

Figure 113: Removing the Cover 

 6. Close the aperture on the existing grating. 

 

Figure 114: Removing the Existing Grating 

 7. Remove the existing grating from the unit by pulling gently directly 

away from the unit. Place in a plastic bag to prevent dust build up, 

and set to one side. 
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Figure 115: Remove the Grating 

 8. Remove the filter assembly from the unit, using the handle to pull 

directly outwards from the unit. 

 

Figure 116: Remove the Filter Assembly 

 9. Unpack the alternative wavelength Laser kit and check all parts 

are present: 

• Laser assembly 

• Filter assembly 

• Grating 

10. Fit the new grating to the unit, aligning the plastic tab with the 

recess in the housing. The grating will be pulled into place and 

held firmly by magnets 
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Figure 117: Fitting the New Grating 

 11. Open the grating aperture by turning the tab on the outside of the 

grating to the position shown with an open window. 

 

Figure 118: Opening the Grating Aperture 

 12. Fit the new filter assembly into place, with the handle facing 

outwards and the magnet facing upwards. Like the grating, the 

magnets locate the filter assembly in the correct place. 
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Figure 119: Fitting the New Filter Assembly 

 13. Replace the cover of the iXR unit and fix in place using the four 

captive screws. 

14. Locate the new Laser assembly onto the slide at the rear of the 

unit, push in towards the unit and lock into place by twisting and 

rotating upwards the black handle on the rear. 

 

Figure 120: Locking the Unit into Place 

 15. Remove Log-out Tag-out; Switch system ON at main power 

switch 

16. Open the OMNIC software 

17. Align and Calibrate the unit following the instructions in the 

section iXR Unit Alignment and Calibration, page 124. Ensure 

that the Alignment and Calibration completes successfully. 

 

NOTE: If Alignment/Calibration fails due to “Insufficient counts” then it 

is likely that step 11, opening the grating, was missed out. 

 18. Load a silicon sample into the Nexsa system.  

NOTE: It is useful to locate the sample in the lower left portion of the 

sample holder, as it will then be closer to the phosphor standard 
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sample in the system and will minimise the stage movement 

required. 

SAFETY: During alignments it is prohibited to remove any part of optical 

beam path including mirror covers.  

For detailed safety instructions read the Nexsa G2 Safety Manual 

1213766. 

 19. Move to the _Phosphor position. Confirm the correct analysis 

position (height) by using the x-ray source smallest spot, which 

will be visible on this sample. 

20. Centre the Laser beam on the sample by varying the two 

adjusters on the mirror closest to the Nexsa (reducing the Laser 

power and/or adjusting the optical view settings may need to be 

modified to accurately view the Laser position). See section  

21. Analysis Position Adjustment page 123 for more details. 

 

Figure 121: Centring the Laser Beam  

 22. Move to the silicon sample and locate the sample at the correct 

height (using the Laser beam if visible) 

23. In the Bench tab of the experiment setup dialog, set the silicon 

peak range of 450 – 550 cm-1. Take note of the Max – Min 

number on the display. 

24. Turn the focus adjuster to maximise the sensitivity of the Raman 

signal (highest Max-Min number), noting that: 

a. Some hysteresis may be present in the focus movement, so it 

is preferable to move in one direction only for fine movements 

b. It is wise to average 2 - 3 measurements to ensure an 

accurate measurement of the signal level. 
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Figure 122: Turning the Focus Adjuster 

 25. Once the focus has been optimised, ensure that the spot position 

is still centred on the analysis position. If not, then adjust the spot 

position once more using the adjusters on the mirror closest to the 

Nexsa system. 

26. The new Laser wavelength is then ready to use. 
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Analysis Position Adjustment 

 From time to time it may be necessary to make small readjustments 

of the Laser spot position on the sample, in to maintain a good match 

with the XPS spot position. This section details the best way to 

complete this adjustment. 

 1. Move to the ‘_Phosphor’ position. 

2. With the Laser turned off (or blanked), ensure that the smallest x-

ray spot and optical view crosshairs agree, as well as the 

crosshair on the height-setting camera. If necessary, either the x-

ray spot position, TTL camera or Height setting camera should be 

adjusted such that the positions are coincident (such adjustment 

is detailed in the Nexsa setup procedure). 

3. Turn the Laser on at low power (0.1 mW) and check that it is 

visible on the ‘phosphor’ sample. 

4. Use the adjustment screws on the mirror closest to the Nexsa 

system to move the spot on the sample, as per diagram below.  

    

 

 

 

 

 

 

 

 

 

Figure 123: Screw Adjustment on Mirror  

SCREEN 

SCREEN 

Anticlockwise 

Clockwise 

Clockwise 

Anticlockwise 
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NOTE: There is a limited range of movement before the spot will dim 

and/or start to reflect from the edges of the conduit leading to 

the system. If the spot cannot be centred then further 

adjustments will be required. Contact your local service 

representative. 

 

 

 

 

 

iXR Unit Alignment and Calibration 

 If the operating environment (e.g. temperature etc.) does not change, 

then it it is expected that the iXR Raman spectrometer will continue to 

perform at the optimum level with time. However, at least once per 

year the iXR Raman spectrometer will require calibration and 

alignment in order to maintain maximum performance, and calibration 

will be required if a different wavelength Laser and grating etc. has 

been installed (see Changing Laser Wavelength page 116). This 

calibration can be undertaken by the user at any time through the 

OMNIC software generally takes less than one hour to complete.  

 The iXR unit has an internal calibration unit which is used for both 

Laser alignment and energy scale calibration. 
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Laser Fine Alignment 

 Fine adjustment of the Laser trajectory to best match the Raman 

collection path is necessary to ensure best performance from the unit. 

This is a software automated process and is run through the OMNIC 

software. 

 1. Open the Experimental Setup dialog box. 

2. Switch to the Bench tab. 

3. Turn the Laser on and set to 10 mW output power (532 nm 

Laser). 

4. Switch to the Alignment tab. [It may take some time for the tab to 

become active]. 

5. Click on the Align laser using Raman Signal button.  

6. The automated alignment process will begin after a short delay 

(during which the spectrometer is being prepared into the correct 

state to perform the alignment). If the automated alignment does 

not start, click the Auto Align button at the lower right corner of 

the dialog box to begin the process. You will observe the Side to 

side and Up/Down Laser Fine Adjust numbers changing. 

7. Wait for the auto-alignment process to complete. At this point you 

should observe a Max number in excess of 10,000 in the top left 

corner of the spectrum display. 

• If a number less than 10,000 is observed then it is likely that 

there is a problem with the Raman spectrometer - contact 

your Thermo Scientific service representative. 

 

Figure 124: Experiment Setup Alignment Tab 
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 8. Click OK to close the Experiment Setup dialog box. 

NOTE: At this point you may get a dialog asking if you wish to 

Calibrate. Clicking Yes will automatically kick off the unit 

calibration routine outlined in the next section. If it does not kick 

off the procedure, follow the procedure outlined in the 

Calibration section below. 

Calibration 

 If the Laser fine alignment has been performed, or if the energy scale 

appears incorrect then it is likely the unit requires calibration. 

Calibration of the iXR Raman spectrometer is an automated process 

accessed through the OMNIC software: 

 1. From the File menu select Collect > Calibrate Instrument. 

2. The automated calibration process will begin.  

3. This process generally takes a few minutes to complete, but can 

take longer if the Laser wavelength has been changed. After 

completion you should see a message stating calibration was 

completed successfully. 

If any step shows as failed or not completed successfully, contact 

your service representative. 

 

Figure 125: Information Dialog Box 

 4. Once the calibration is complete, turn the Laser off using the 

Experiment Setup dialog. 
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Optional Sample Holders 

Tilt Sample Holder 

 

Figure 126: Tilt Sample Holder 

 The optional tilt sample holder allows angle dependent XPS data to 

be acquired. Samples to be investigated must be no bigger than 

26 mm x 5 mm x 5mm and be mounted in the sections labelled A-D 

on the tilting bar. Samples must not over-hang the edges. It is 

recommended to mount samples using tape to prevent shadowing 

of sample areas. It is also necessary not to cover the calibration 

cross marking on the right side of the tilting bar. 

 After the sample is loaded into the Nexsa, the checkbox on the 

sample tab needs to be selected to change the rotation controls to 

the tilt controls. Once the sample holder is removed, this should be 

deselected so that the motor settings are returned to the default 

azimuthal rotation mode. 

 

Figure 127: Setting Stage Tilt Holder 
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 Once the sample holder has loaded into the analysis chamber, the 

tilt axis needs to be calibrated (full details can be found in the 

Avantage help file). 

 • Click Move to Tilt Axis Calibration Point. 

• The flat position (0°) must then be found. There are two ways of 

doing this. Either adjust the tilt controls in the lower right of the 

optical view so that the top and bottom edges of the tilt bar are 

in focus at the same Z position. An alternative method is to turn 

on the co-axial light and adjust the tilt until the reflected light on 

the right of the calibration cross is at its brightest. At this point 

the tilt bar is flat. After using either of these methods, the Datum 

Tilt Axis button should be pressed to set the angle to (0°). 

• The Z-position of the sample should then be optimised, either 

using the two camera views or the XPS signal. 

• Once the height is set, move to the centre of the cross and 

press the Set Tilt Axis Calibration Point button. The tilt stage 

is now ready for use. 

 Experiments are set-up as described above, but use the Stage Tilt 

object from the Line Insert icon on the Experiment tab. The 

recommended angular range is 0-60°. Remember that the signal 

intensity will decrease as the angle increases, and so larger 

numbers of scans or snapshots may be necessary to obtain data 

with good signal:noise characteristics. 

              

Figure 128: Stage Tilt  
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Bias Sample Holder 

 

Figure 129: Bias Sample Holder 

 The optional bias sample holder allows work 

function measurements of samples to be 

performed. The work function is measured 

by extrapolation of the low kinetic energy 

spectrum cut-off, but this can be convoluted 

with the cut-off of the spectrometer. To 

separate the sample cut-off from the 

spectrometer cut-off, a negative bias voltage 

needs to be applied to offset the spectrum to 

higher kinetic energy. The module has an 

electrically isolated top-plate, which connects 

to an in-vacuum connector using spring-

loaded contacts, allowing a bias voltage to 

be applied. 

 Samples should be clipped to the sample 

block, and the electrical contact between the 

top surface and the top plate should be 

good. The sample block is loaded into the 

system in the usual way. 

 

Figure 130: Ion Gun Details. Sample Current Tab 
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 The sample bias is applied using the ion gun 

details dialog. Open the dialog and turn on 

the sample bias. Set the polarity to negative, 

and the mode to Sample Current. This will 

apply a bias of -30 V to the sample. The 

sample bias indicator will be green to show 

that the bias is being applied and can be 

clicked on to directly access the bias control. 

The sample bias can also be controlled from 

the UV source object in the experiment tree if 

a UV source is fitted. 

 A silver standard is supplied with the holder 

to allow testing of the system. Clean silver 

should have a work function of around 4.0-

4.5 eV. As an example, this is the procedure 

to take a measurement on the silver 

standard. 

 • Clean the silver sample using the ion gun 

• Collect two spectra 

• Cut-off: pass energy 3-10 eV, range 

32 -> 38 eV (Kinetic), 10 scans 

• Fermi level: pass energy 50 eV, 

range -25 -> -35 eV (Binding), 10 

scans 

• Measure the position of the Fermi level, 

and shift both spectra so that the Fermi 

Level is at 0 eV. This determines the 

exact bias applied to the sample. 

• Use the Work Function Measurement 

tool in Avantage to determine the work 

function. The work function is obtained 

by subtracting the cut-off position from 

the photon energy (on the Nexsa this is 

1486.6 eV ± up to 200 meV; the error in 

the photon energy is determined during 

the energy scale calibration, and can be 

found in the calibration folder in 

C:\AvantageSystem for the best 

accuracy). 

1213765/C - Production



 

Nexsa G2 Surface Analysis System      131 

 

Figure 131: Work Function 
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Work function measurement tool, found on 

the Analysis tab 

 At the end of the experiments, it is important 

to remember to turn off the sample bias and 

change the other radio buttons to “Pos” and 

“Faraday Cup”.  

  

Customer Bias Interface  This sample holder may also be used to 

provide low voltage and low current 

connections to a sample to allow additional 

flexibility in situ bias or measurement 

operations. 

The customer bias interface is a 15 way D-

type connector on services connection panel 

of Nexsa G2. 
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This sample holder may also be used to provide 3 

low voltage / low current connections to a sample to 

for additional flexibility in situ bias or measurement 

operations.  Applying voltages or currents may 

produce electrical and magnetic fields around the 

sample which may distort the shape, intensity and 

energy resolution spectrum. 

The customer bias interface is a 15-way D-type 

connector on the services panel of Nexsa G2. 

Maximum Voltage = 50V AC or DC 

Maximum Current = 750mA 
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Vacuum Transfer Module 

 

Figure 132: Vacuum Transfer Module 

 The optional vacuum transfer module allows samples to be 

transferred from a glove box environment into the Nexsa system 

without exposure to air. The device comprises three parts, the 

aluminium cover, the lower sample holder assembly, and the 

clamping bar. 

 

Figure 133: Vacuum Transfer Module Parts 
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Operation 

 The parts should be loaded into the glove box separately, to prevent 

the device sealing during the antechamber evacuation cycles. 

Samples can then be mounted onto the top plate. There are four 

positions for the sample mounting top plate, as shown in the following 

images. 

   

Figure 134: Sample Plate Flat Side (Left) and Raised Side (Right) 
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Position 1 

 

Raised side 
up 

 

Sample thickness range 
0 – 1 mm 

Position 2  

 

Flat side up 

 

Sample thickness range 
0 – 2 mm 

Position 3 

 

Raised side 
up 

 

Sample thickness range 
2 – 5 mm 

Position 4 

 

Flat side up 

 

Sample thickness range 
3 – 6 mm 

 

Table 13: Sample Plate Positions 

 Samples can be mounted using the clips in the standard Nexsa 

sample kit (supplied with the instrument) or using tape. Once the 

samples are mounted, the unit needs to be sealed. The upper section 

has two pins that engage with the two gaps on the edges on the 

holder. 
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Figure 135: Transfer Module Pins 

 Once the unit is closed the clamp bar needs to be fitted, as shown 

below. This keeps the unit together until it is pumped down, 

maintaining the inert atmosphere. Care must be taken to ensure that 

the o-ring seal is clean before closing. 

 

Figure 136: Clamping the unit for pump down (done inside the glove box). 

Ensure that the clips engage before tightening the thumb screws. 

 The clamped unit must then be pumped out. It is recommended to 

use the glove box antechamber to do this as the sample holder is 

transferred out. Pump the unit for about 10 minutes to ensure that it is 

fully evacuated. If it is not possible to pump the unit in the glove box, 

then a pipe can be attached as shown below, and the unit pumped 

using a standard rough vacuum pump. 
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Figure 137: Pumping the Clamped Unit 

 To transfer the holder into the Nexsa system, the clamp bar must first 

be removed. External air pressure will hold the unit together once it is 

evacuated.  

IMPORTANT: The module should be loaded into the Nexsa system within 30 

minutes of pump down. Longer delays risks the o-ring sticking 

and causing an unsafe release of the base in the instrument. 

 Fit the module into the Nexsa load-lock, making sure that the side 

marked FRONT is at the front of the instrument, and that the clips on 

the aluminium section engage correctly on the edges of the load-lock. 

 

Figure 138: Fitting the Module into the Load Lock 

 The sample holder can then be pumped down using the Pump and 

Park button. 
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Figure 139: Pump and Park Button 

 The unit will separate during the pump-down, when the vacuum level 

in the load-lock goes below the level inside the holder. To ensure 

separation it is important to allow the unit to pump for 15 

minutes before transferring into the analysis chamber. 

 After analysis, the unit can be unloaded from the system as usual. 

The two parts will stay separate when unloading from the system (i.e. 

the inert transfer is one-way only). 

Troubleshooting & Maintenance 

 The vacuum transfer module needs little maintenance. The sealing 

faces need to be kept clean and free of scratches to ensure that the 

unit pumps down and seals correctly. The position of the ball valve is 

set with a small grub screw. This can be adjusted using a 2 mm hex 

wrench if required. Replacement parts for the valve are supplied with 

the module, comprising the O-ring, ball, spring and grub screw; the 

assembly is shown in the figure below. 

 

Figure 140: Replacement parts 

O-ring 
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Vacuum Transfer Module Operation Flow Chart 

 

Figure 141: Vacuum Transfer Module Operation Flow Chart 

Set the sample 
plate height for 

sample thickness

Loas parts into 
the glove box

Attach samples 
to plate

Close transfer 
module and 
apply clamp

Pump down 
module

Remove clamp 
bar

Load into system
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NX-Heater 

The NX-Heater provides the option to control the sample temperature from 25°C to 

800°C (under recommended chamber pressure <10ˉ⁸ mBar) when using the Thermo 

Fisher Scientific Nexsa G2.  

WARNING!  

Whilst the NX-Heater is able to control sample heating up to 800˚C, maintaining 
maximum temperature operation for prolonged periods may affect the lifetime of 
the NX-Heater chip. 

Venting the XPS chamber switches off the heating. 

Be aware of the thermal hazard. Refer to the User Safety manual for the details.  

When operating the heating stage, please be aware that neighbouring surfaces 
can become hot; stage temperature is displayed in the NX-Heater module / 
General tab / Monitored Values ˚C item.  

The NX-Heater consists of the following parts:  

• NX-Heater assembly (NX-Heater holder base block, NX-Heater MEMS chip, dual-

size sample mask)  

• Chamber feed-through 

• MEMSC (Micro Electro Measuring System Controller)   

 

 

Figure 146: NX-Heater MEMS heating block with chip and sample mask installed 
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NX-Heater consumables  

The NX-Heater option is supplied with 5 NX-Heater MEMS chips (Figure 147) and 10 NX-

Heater sample masks (Figure 148). Additional units can be purchased direct from Thermo 

Fisher Scientific. 

NX-Heater MEMS chips should be disposed of according to local electronic waste & 

recycling guidelines. 

NX-Heater sample masks can be disposed of subject to standard waste disposal regulations 

for your area, but should be isolated and processed separately from non-copper-beryllium 

scrap in the case of recycling. 

  

Figure 147: NX-Heater MEMS chip 

 

 

  

Figure 148: Dual-size sample mask. (Top) Unmounted mask and NX-Heater chip. 

(Bottom) Mask options, as they appear over a NX-Heater MEMS chip, when 

mounted onto the NX-Heater block. 

 

 

 

1213765/C - Production



 

Nexsa G2 Surface Analysis System      143 

NX-Heater Installation  
Caution!  

Use dust free gloves when handling the NX-Heater block and consumables. 

NX-Heater Chip installation  

Caution!  

The NX-Heater chips are fragile. Extreme care should be exercised during handling 
and sample placement to prevent damage to the heating window. The use of soft-
tipped, flat-edged tweezers is recommended.  
It is advised that where samples may have sharp or protruding edges, these be 
positioned outside the heater window area to prevent damage to the membrane. 

The window area of an NX-Heater MEMS chip is 2.5 mm² and encases a suspended heating 

filament with a diameter of 1.5 mm. Customers should consider these dimensions when 

loading samples for analysis onto the NX-Heater chips. 

 

  

Figure 149: Loading a chip onto the NX-Heater block (Note: chip orientation) 
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Loading a chip onto the NX-Heater block (Figure 149): 

1. Depress the two spring-loaded contact pins and hold 

2. Slide the MX-Heater chip into the recess between the two sets of depressed pins 

3. Carefully release pressure on the spring-loaded contact pins 

4. Make sure that the pins are on the contact pads of the chip, and that the chip is 

secured 

5. Select the required analytical field of view using one of the two provided mask sizes 

and place over the top of the NX-Heater chip 

6. Replace the spring clip arm over the edge of the mask to hold the mask in place  

 

Caution!  

Ensure that the mask is not touching the contact pins or chip pads before loading the 
NX-Heater block into the Nexsa G2. 
 
 

NX-Heater Stage Block installation  

 

The NX-Heater block replaces the standard sample block. Once the sample and NX-Heater 

chip have been loaded onto the NX-Heater block, it should be loaded into the Nexsa G2 

outlined in “Sample Loading”. 

 

Sample exchange  

Caution!  

Customers must consider the effect of heat upon a sample, and the effect that any 
changes may have on the system. For example, materials that will produce toxic 
volatile compounds (that could linger in the chamber); and materials that could 
release compounds that could damage the instrument (for example, sulphur). 
Thermo Fisher Scientific can take no responsibility for the results of heating materials 
within the instrument. The usual restrictions for room temperature XPS still apply - for 
example, samples must be compatible with a high vacuum environment, no H, or He. 

The procedure for sample exchange when using the NX-Heater block is as described in 
“The Sample Page”. 

 

Software control   

 

The NX-Heater is software controlled through Avantage and can be monitored throughout 

using with the NX-Heater module (added when NX-Heater is installed). If the stage is 

installed and detected, the module shortcut (with connection status) will appear in the 

bottom left of the Avantage software – alongside the gun status icons. 
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Software will verify the presence of the NX-Heater stage, and a chip in the NX-Heater block. 

If either is not present, then the NX-Heater module will show as disconnected in Avantage. 

Additional information will be given in the NX-Heater module under Comms and Feedback 

(Figure 150). Heating controls will also be unavailable. 

 

Figure 150: NX-Heater module connection status readout 

 

The NX-Heater is designed to be used under vacuum. This will be verified via an interlock, 

the status of which can be monitored in the Interlocks tab > Trips > Vacuum Interlock on 

NX-Heater module (Figure 151). Heating controls will be unavailable if this interlock is 

tripped. 

 

Figure 151: Interlocks tab on the NX-Heater module 
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Calibration  

When an NX-Heater Chip is replaced (or after Avantage Server restart), open the NX-

Heater module > General tab > Calibration > Calibration Coefficient and input the calibration 

coefficient provided on the NX-Heater chip package for the installed chip (Figure 152). Click 

the Calibrate button to store the value and initialise calibration of the chip. 

Caution!  

The NX-Heater is calibrated according to the Callendar-Van Dusen equation for 
resistance and temperature. Using a calibration coefficient value that is not concurrent 
with the chip being used can result in a significant discrepancy between the 
programmed temperature and the actual temperature of the chip heating filament. 

When utilising the NX-Heater as part of an Avantage experiment process, the calibration 

coefficient can also be changed in the NX-Heater tab > Heater Parameters > Calibration 

Coefficient of the NX-Heater object properties panel (Figure 153). 

 

Figure 152: General tab on the NX-Heater module 
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. 

Figure 153: NX-Heater tab of the NX-Heater object properties panel 

 

Monitored Values 

 

 

Figure 154: Details tab on the NX-Heater module 

 

When the NX-Heater is connected, the NX-Heater module continuously updates readouts of 

monitored values at a frequency of at least 1 Hz. The temperature and resistance are 

displayed under the General tab > Monitored Values (Figure 152). The instantaneous 

current, voltage and power values can be viewed in the Details tab > Additional Readouts 

(Figure 154). 
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Temperature Control and Experiment Building 

 

Due to the design of the NX-Heater, samples will be isolated from ground. Therefore, prior 

to any heating investigations using the NX-Heater, it is important to ensure that the sample 

is properly charge compensated. Typically, this will require a FG emission of at least 120 μA 

and a pressure of less than 9E-08 mBar in the analysis chamber. 

The temperature can be instantaneously controlled in the General tab > Target Values > 

Temperature box of the NX-Heater module. The NX-Heater can be manually turned on or 

off using the Turn On/ Turn Off buttons.  

The NX-Heater can be controlled as part of analytical experiments using the NX-Heater 

object in an Avantage experiment tree. An example is given in Figure 155, however the NX-

Heater object is independent of the gun control objects, and so can be placed in most 

positions in the tree. 

 

 

Figure 155: An Avantage experiment tree utilising the NX-Heater object.  

(Note: The Flood Gun should be used for MEMS experiments) 

 

The NX-Heater object provides the option autonomously heat a sample in discrete steps, up 

to a given temperature. This function can be controlled in the Heating Phases tab of the 

object properties panel, which allows the user to define the temperature and number of 

heating steps (Figure 156).  

Avantage will then repeat the dependent objects below the NX-Heater (e.g. both Point 

objects in turn and their respective XPS Surveys in Figure 155) in the experiment tree at 

each defined temperature step. The first iteration can be set to be taken with the heater 

turned off using the Do an initial scan with the Heater turned off tick box (Figure 157), with 

the heating steps then being conducted after this initial pass. 
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.  

Figure 156: The Heating Phases tab of the NX-Heater object properties panel with an 

example 2-phase temperature ramp.  

 

Additionally, the temperature ramps can be split into heating “phases”, which allow for 

differential step rates to be conducted within one experiment. In the example given in Figure 

156, Phase 1 heats the sample up to 200˚C in 4 steps of 50˚C, whilst Phase 2 brings the 

temperature down to 100˚C in 4 steps of 25˚C. In the example in Figure 155, this would 

result in a total of 20 XPS surveys having been collected at the end of the experiment, if the 

Do an initial scan with the Heater turned off tick box is checked (Figure 157). 

At the conclusion of the experiment, the NX-Heater will be held at the Final Temperature of 

the final Phase – for example, the NX-Heater would remain at 100˚C at the end of the 

experiment given in Figure 156. To automatically turn off the heater at the conclusion of the 

defined experiment, check the Turn off heater at the end of experiment tick box on the NX-

Heater tab of the NX-Heater object panel (Figure 157). 

 
a 

Figure 157: The NX-Heater tab of the NX-Heater object properties panel  
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The General tab on the NX-Heater object panel will show the estimated duration of the NX-

Heater object and its dependents (Figure 158). 

 

. 

Figure 158: The General tab of the NX-Heater object properties panel for an example 

2-phase temperature ramp 
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Appendix 1: Processing 

Commands 
 For full information on the commands, please see the online 

Avantage help file. 

Analysis 

 
Survey ID 

 
Manual peak ID 

 
Add peak 

 
Peak fitting 

 
Peak table profile 

 
Charge shift 

 
Chemical state assessment 

 
Non-linear least squares fitting 

 
Target factor analysis 

 
Principal components analysis 

 
eSP – Enhanced survey processing 

 
Band Gap Measurement 

 
D-parameter measurement 

 
Work function measurement 
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Compare & Overlay 

 
Lightbox compare 

 
Overlay 

 
Overlay manager 

 
Image overlay 

 
Overlay image on optical image 

 
Combine 

Modify 

 
Smooth 

 
Energy deconvolution 

 
Differentiate 

 
User background 

 
PCA reconstruct 

 
Spin-orbit subtract 

Arithmetic 

 
Add a constant 

 
Subtract a constant 

 
Multiply by a constant 

 
Divide by a constant 

 
Add spectra 

 
Subtract spectra 
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Multiply spectra 

 
Divide spectra 

Profile 

 
Smooth profile 

 
Interface width calculator 

 
Time to depth 

 
Split profile 

 
Escape depth correction 

Image 

 
Average spectrum 

 
Smooth image 

 
Line / band scan 

 
Interpolate scattered data 

 
Phase analysis 

 
Split image 

 
Image deconvolution 

Utilities 

 
Clone dataspace 

 
Crop / Collapse dataspace 

 
Trim dataspace 
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Export data 

 
Import data 

 
Resample data 

Angle Resolved XPS 

 
Relative depth plot (requires tilt module) 

 
Single overlayer calculator 

 
Multi-overlayer calculator (requires tilt module) 

 
ARProcess (requires tilt module) 
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Appendix 2: Display & 

Reporting Commands 
 For full information on the commands, please see the Avantage help 

file. 

Display Modes 

 
Single trace 

 
2D chart 

 
Stacked chart 

 
3D chart 

 
2D image 

 
Relative depth 

 
Bar chart 

 
Information 

 
Energy spectrum 

 
2D image X-Y 

 
Display as profile 

 
Chart properties 

Display Options 

 
Toggle user annotations 

 
Toggle peak labels 

 
Toggle fitted peaks 
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Toggle residual 

 
Toggle peak backgrounds 

 
Toggle user backgrounds 

 
Sum data series 

 
Display spectrum in binding energy mode 

 
Display spectrum in counts per second mode 

 
Reverse energy axis 

Reporting 

 
Report to MS Word 

 
Report to MS Excel 

 
Report to clipboard (use for reporting to MS PowerPoint) 

 
Report preferences 

 
Number of spectra on one row of report output 

 
Include selected empty grid cells 

Process Grid Icons 

 
Save peak table 

 
Load peak table 

 
Toggle constraint display (Peak fit table) 

 
Lock selected constraints (Peak fit table) 

 
Clear selected constraints (Peak fit table) 
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Propagate constraints (Peak fit table) 

 
Resizable cells 

 
Maximise selected cells 

 
Tile cells 

 
Size all cells to current cell size 

 
Size all cells to default cell size 

 
Add cells 

 
Subtract cells 

 Grid preferences 

 
Axis preferences 
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